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Foreword to the First Edition

xxi

IT’S A SMALL CELEBRATION for me to write this foreword—almost exactly
two years after the first meeting of a small group of free software profes-
sionals that turned into the Ubuntu project. A celebration because two
years ago none of us would have predicted that our dream would spawn
several million CDs, three or four million enthusiastic users, hundreds of
commitments of support from companies large and small, a minor prime
time television reference, and now The Official Ubuntu Book.

The dream that brought us together can be simply expressed:

To build a world-class operating system for ordinary desktop computer
users, that is genuinely free and freely available, that is immediately useful,
and that represents the very best that the free software world can achieve
today.

In setting out to build a platform for “ordinary desktop computer users,” I
had no idea that I would have the privilege of meeting and working with
so many extraordinary desktop computer users. Some of those extraordi-
nary individuals are the authors of this book, people who both understand
the importance of the free software movement and have the talent to have
been real contributors to its success. Others make up the backbone of the
Ubuntu community—the small but dedicated army of a few hundred
people that works to produce a new release of Ubuntu every six months.
They are at the heart of a network that reaches out through the global free
software community—through the world of Debian, an extraordinary
project in its own right and without which Ubuntu could not exist, and on
out to the thousands of projects, large and small, that produce the code
and documentation that we pull together and call Ubuntu.



While this huge extended community can often appear to be fractured and
divided along infinitesimal ideological lines, we are all broadly in agreement
about four key ideas, and it is those ideas that are central to the Ubuntu
promise:

� That our software should not come with a license fee. That we should
be able to share our software, modify it, and then share our modifica-
tions, too.

� That this free software should be the best version available, including
regular security updates, and not a tease for a better, commercial
product.

� That full-scale, high-quality commercial support from local and
global companies should be available for this free platform.

� That this software should be usable in as many languages as possible
and usable by as many people as possible regardless of disability.

The 17 of us who met in London two years ago come from a very wide
variety of countries and backgrounds, but we all agreed that the goal of
producing a platform that could live up to that promise was a worthy one,
one that we would devote ourselves to wholeheartedly.

For several months we worked quietly. We wanted to come to the world not
only with a manifesto but also with a clear demonstration of work done
toward our goals, something that people could test and comment on. We
had no name (though industry insiders called us the “Super-Secret Debian
Startup”), and, as a result, we hosted most of our work at www.no-name-
yet.com. We were looking for a name that could express the beauty of the
free software community development process—collaboration, interde-
pendence, sharing, standing gently on the shoulders of giants, and reaching
for lofty goals. The only word that comes close to that, of which I’m aware,
is the African word ubuntu. It is found in many forms in many different
African languages. And so we adopted it as the name of our project. 

We knew that our first release would have blemishes—warts—and gave it
the codename “The Warty Warthog.” We called ourselves “the warthogs”
and coordinated our work on the #warthogs IRC channel. Today, for bet-
ter or worse, that’s turned into a tradition of codenames such as “Breezy
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Badger” and “Dapper Drake.” As lighthearted as they sound, these code-
names come to embody the spirit of our community as it works toward a
particular release. This next one—Dapper—is exactly that: a man emerg-
ing from youth, professional, bold, confident, and energetic. This is our
first release that is designed to meet the needs of large organizations as
much as developers and engineers. In the same way, the Ubuntu commu-
nity has moved from being something of a rebellion against the “Linux
establishment” to a strong and professionally organized group.

What Makes Ubuntu So Popular?
First, this is the time for free software to come to the forefront, and
Ubuntu is very much the beneficiary of the vast amount of work that has
gone into building up a huge body of work in the GNU/Linux world. That
work has been underway for nearly 30 years, in one form or another, but
Ubuntu is one way in which it is suddenly becoming “visible” to the non-
specialist computer user. We are in the middle of a great overturning of the
industry status quo. The last time that happened, in the mid-1990s, was
when the world suddenly found itself connected to itself—by the Internet.
Every major company, especially those in the field of technology, had to
examine itself and ask the question, “How do we adapt to an Internet
world?” Today, every major technology company has to ask itself the ques-
tion, “How do we adapt to a free software world?”

I would speculate and say that Ubuntu represents an idea whose time has
come. We did not invent the free software movement—that honor goes to
Richard Stallman and many others who had a vision far more profound at a
time when it was hard to see how it could ever become reality. But Ubuntu
has perhaps the honor of bringing that vision to a very wide audience in a
form that we can all appreciate. I hope that the real visionaries—those who
have led the way—will appreciate the decisions and the choices we make in
bringing you this project. Some will take exception—I know Linus prefers
KDE to GNOME, for example, so he’s likely to be more of a fan of Kubuntu
than Ubuntu. But in general, the ideas that others have had, the principles
of the free software movement, are well expressed in Ubuntu.

Second, Ubuntu is a project on which you can have a real impact. It has the
benefit of deep and reliable financial backing and a corporate team to give
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it muscle, but it is in every regard an open project, with participation at the
highest levels by true volunteers. We work in a fishbowl—our meetings take
place online, in a public forum. That can be tricky. Building an operating
system is a fast-paced business full of compromise and tough decisions in
the face of little information. There are disagreements and dirty laundry,
and mistakes are made. (I should know; some of them are mine. You should
hear the one about the Warty Warthog desktop artwork.) The transparency
of our environment, however, means that we can count on having robust
conversations about our options—all of them, even the ones the core team
would never have dreamed up. It also means that mistakes are identified,
discussed, and ultimately addressed faster than they would be if we lived
and worked behind closed doors. You get a better platform as a result.

We work hard as a community to recognize the contributions of all sorts
of individuals—advocates, artists, Web forum moderators, channel opera-
tors, community event organizers, writers, translators, people who file and
triage bugs . . . whatever your particular interest or talent, we will find a
way to integrate your contribution.

Perhaps most important is the way our approach to community differenti-
ates Ubuntu from other free software projects with similar vision. We try to
do all of this in a way that recognizes that disagreements are important but
prevents those disagreements from creating deep divides in our commu-
nity. Our code of conduct may not be perfect, but it reminds each of us to
remember the meaning of the word ubuntu—that each of us has our best
impact through the relationships we maintain with one another. Finding
common ground and maintaining healthy communication are more
important for us as a community in the long run than a particular technical
decision or the specific choice of words with which to translate “File” into
Spanish. Our community governance structures—our Technical Board
and Community Council—exist to ensure that debates don’t become per-
sonal and that decisions can be taken after all sides have been heard.

If you are a software professional or curious about Linux, this book and this
platform are an excellent choice. You will learn about the world of Ubuntu
and, indirectly, Debian and GNU/Linux. These are great foundations for
working with the tools that I believe will come to define the “standard,” the
everyday computing base upon which we build our homes and offices.

xxiv Foreword



I once heard a proprietary software vendor say, “Linux is more expensive
because skilled Linux professionals are more costly.” This is true. It means,
of course, that Linux skills are more valuable! It won’t be true forever
because the world of Linux is expanding so rapidly that sooner or later we
will have to accept a position in the mainstream, and that takes off some of
the “geek points” associated with being part of the “future of technology.”
But right now, without a doubt, being ahead of the curve on Linux and on
Ubuntu is the right place to be. If you’re this far into this foreword, you are
clearly going to make it. ;-) 

It’s difficult for me to speculate on what the future might hold for the
Ubuntu project. I know that I along with many others are loving the
opportunity to be at the center of such an exciting initiative and are com-
mitted to seeing where it leads us over the coming years. I believe that it
will become a pervasive part of our everyday computing environment, so I
would like to help make sure that we don’t make too many mistakes along
the way! Please, come and join us in the fishbowl to help ensure we do a
very, very good job.

—Mark Shuttleworth
Ubuntu Founder

April 2006
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AS WE WRITE THIS, it has been several years since we penned the first edition
of The Official Ubuntu Book. Over that time, we have seen Ubuntu continue
its explosive growth. Updating this book drives this fact home in striking
ways. For example, the number of users and posts in the Ubuntu Forums
has nearly doubled since the last edition of this book a year ago. Again. The
number of officially supported flavors of Ubuntu have been added to.
Again. Once again, we feel blessed that The Official Ubuntu Book has been
able to benefit from, and perhaps in a small way even contribute to, that suc-
cess. Ultimately, that success paved the way for several subsequent editions,
and now the fifth edition of the book that you’re reading now.

In the process, this book, like Ubuntu, continues to mature. Our job as
authors, like that of the Ubuntu developers, now involves more updating
and polishing than it used to. Distributed under a free license, a once-risky
book on a once-risky operating system is, just a few short years later, as
close to a sure thing as an author, publisher, and if we have done our job
well, a reader, could hope for.

And yet with success comes responsibility to our readers and to our users
with high expectations. Ubuntu’s success is built in part of maturity and
excellence, and it cannot sacrifice these qualities if it will succeed. We can-
not either. Our job as writers is complicated because we need to accurately
reflect and represent both while catering to an increasing and increasingly
diverse group of users.

As we’ve noted in the prefaces to previous editions of this book, being
Official has carried with it a set of rights and responsibilities. Our book’s
title means that we must attempt to reflect and represent the whole
Ubuntu community. While we, as authors, are expected to put ourselves
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into the book, it is understood that it can never be to the detriment of the
values, principles, technologies, or structures of the Ubuntu community.

Doing this has been complicated as Ubuntu has grown. In each edition, we
have added new information, because the Ubuntu community has grown
to include new projects. In each revision of this book, we have needed to
add to the list of related projects, tools, and community initiatives. As the
Ubuntu community grows, it is impossible to give a complete accounting
of what Ubuntu has to offer. Creating a summary requires some hard deci-
sions. At the end of the day, we are constrained by page count and our own
limited schedules.

Meanwhile, as with earlier editions, we needed to write this book about a
new release of Ubuntu while that version was under active development
and was being redesigned, rethought, and rebuilt. Every day, Ubuntu grows
in different, unpredictable ways, and this growth has increased exponen-
tially with the size of the community and the diversity of the userbase. Our
book’s development process had to both match and track this process as
our content was crafted, rewritten, adjusted, and allowed to mature itself.

As in the previous edition, the contributors to this book go well beyond
those listed on the book’s cover. Invisible to most readers, dozens of mem-
bers of the community left their mark on different parts of the text of this
book. Although this degree of participation led to a writing process that
was as hectic, and at times frustrating, as the process that builds Ubuntu,
we hope we can remind readers of the level of quality that this process
inspires in our book’s subject. In the places where we achieve this, we have
earned our book’s title. With that goal in mind, we look forward to future
versions of Ubuntu and editions of this book wrought through the same
community-driven process.
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WELCOME to The Official Ubuntu Book, Fifth Edition!

In recent years, the Ubuntu operating system has taken the open source
and IT world by storm. From out of nowhere, the Little Operating System
That Could has blossomed into a full-featured desktop and server offering
that has won over the hearts of users everywhere. Aside from the strong
technical platform and impressive commitment to quality, Ubuntu also
enjoys success because of its sprawling community of enthusiastic users
who have helped to support, document, and test every millimeter of the
Ubuntu landscape.

In your hands you are holding the official, authorized guide to this impres-
sive operating system. Each of the authors selected to work on this book
has demonstrated a high level of technical competence, an unbridled com-
mitment to Ubuntu, and the ability to share this knowledge in a simple
and clear manner. These authors gathered together to create a book that
offers a solid grounding to Ubuntu and explains how the many facets and
features of Ubuntu work.

About This Book
At the start of every book, on every bookshelf, in every shop, is a para-
graph that sums up the intentions and aims for the book. We have one
very simple, down-to-earth aim: to make the Ubuntu experience even
more pleasant for users. The Ubuntu developers and community have
gone to great lengths to produce an easy-to-use, functional, and flexible
operating system for doing, browsing, and creating all kinds of interesting
things. This book augments that effort. With such an integrated and flex-
ible operating system, this guide acts as a tour de force for the many things
you can do with Ubuntu.



The Scope of the Book
With so much to cover, we had our work cut out to write a book that could
cover the system in sufficient detail. However, if we were to write in depth
about every possible feature in Ubuntu, you would need to buy a new
bookcase to store the sheer amount of content.

Part of the challenge in creating The Official Ubuntu Book was selecting the
topics and content that can be covered within a reasonably sized book. We
have identified the most essential content and written only about it. These
chosen topics not only include installation, use of the desktop, applications,
multimedia, system administration, and software management, but also
include a discussion of the community, online resources, and the philoso-
phy behind Ubuntu and open source software. As a bonus, we decided to
squeeze in a chapter full of useful troubleshooting recipes that you can use
when you need to troubleshoot problems, and we expanded our discussion
of projects related to Ubuntu that will be of interest to you. We believe this
book provides an ideal one-stop shop for getting started with Ubuntu.

The Menu
Here is a short introduction to each chapter and what it covers.

� Chapter 1—Introducing Ubuntu: This spirited introduction
describes the Ubuntu project, its distribution, its development
processes, and some of the history that made it all possible.

� Chapter 2—Installing Ubuntu: We walk through the installation
process one step at a time to clearly describe how anyone interested
may begin using Ubuntu on their own computer.

� Chapter 3—Using Ubuntu on the Desktop: This is an informative and
enjoyable introductory tour of the Ubuntu desktop, the applications
included, and ways to configure and customize your desktop.

� Chapter 4—Gaining Greater Proficiency: We explore some of the
advanced ways to use Ubuntu, including managing the system. These
features are not vital if you want to use the computer only as a simple
tool, but once you learn how to install and manage software, use
hardware devices and printers, interact with remote computers, use
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the terminal, and run some Windows programs under Ubuntu, you
will find your overall experience even more rewarding and enjoyable. 

� Chapter 5—The Ubuntu Server: This introduction to Ubuntu Server
installation and administration includes coverage of command-line
package management, basic security topics, and advanced installer
features like logical volume management and RAID.

� Chapter 6—More Applications for Ubuntu: Here we discuss some 
of the most interesting and useful options from among the software
packages available for Ubuntu but not installed by default. These
quality programs are interesting and useful, but either there is not
enough space to include them on the installation CD or they are
without as wide of an audience as those programs preinstalled for
everyone.

� Chapter 7—The Ubuntu Community: The Ubuntu community is
larger and more active than many people realize. We discuss many 
of its facets, including what people like you do to build, promote,
distribute, support, document, translate, and advocate Ubuntu—and
we tell you how you can join in the fun.

� Chapter 8—Using Kubuntu: The most popular spin-off project from
Ubuntu is Kubuntu. This chapter provides a solid introduction and
primer for getting started.

� Chapter 9—Mobile and Netbook Editions: There is an exciting
modification of Ubuntu designed for installation and use on
netbooks, the small computers created for portability and long
battery life that are taking the tech world by storm.

� Chapter 10—Ubuntu-Related Projects: There are a number of Linux
distributions based on Ubuntu that you will find interesting and
possibly useful. We discuss some of these as well as projects that are
integral to the creation of Ubuntu, such as Launchpad and Bazaar.

� Chapter 11—Introducing the Ubuntu Forums: For hundreds of
thousands of people, the Ubuntu Forums have provided the first
glimpse of and interaction with the greater Ubuntu community.
Especially for new users, this has become the most important venue
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for support. We explore the forums and the people, history, and
processes that have built them.

� Appendix—Welcome to the Command Line: You can begin to take
advantage of the power and efficiency of the command line with the
clear, easy-to-use examples in our brief introduction.

The Ubuntu team offers several installation options for Ubuntu users,
including CDs for desktop, alternate install, and server install. These three
CD images are conveniently combined onto one DVD included in the
back of this book, allowing you to install Ubuntu for different configura-
tions from just one disk. There is also an option to test the DVD for defects
as well as a memory test option to check your computer.

The first boot option on the DVD, Start or Install Ubuntu, will cover most
users’ needs. For more comprehensive information, check the Help feature
by selecting F1 on the boot menu. You can also refer to Chapter 2, which
covers the Ubuntu installation process in detail.

You can find the DVD image, the individual CD images (for those who
don’t have a DVD drive), and Kubuntu and Edubuntu images on www.
ubuntu.com/download.
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Using Ubuntu on the Desktop



WITH UBUNTU INSTALLED and ready to go, it’s time to get started using your
new desktop. The stock install of Ubuntu provides a very complete and
flexible system. Unlike other operating systems, such as Microsoft Win-
dows or Mac OS X, Ubuntu includes everything you need to get started: an
office suite, media tools, a Web browser, an e-mail client, and more. Once
the installation is complete, you are up and running right away without
having to install any additional software. Different people use their com-
puters in different ways, and every user has her own personal preference
for look and feel. Recognizing this desire, Linux has the capability to use
any one of a number of different graphical interfaces. This flexibility, com-
bined with the ballooning popularity of Linux and open source, has
resulted in literally hundreds of different graphical environments spring-
ing up, each covering these different types of users and ways of working.

Even though there is a huge range of different environments available,
there are two clear leaders in KDE and GNOME. Each environment pro-
vides a good-looking, comprehensive, and easy-to-use desktop, but they
differ in how that desktop is used as well as in how further personalization
can take place. The KDE system aims for complete control and configura-
bility of the desktop. Any desktop configuration options that exist are
available to the user, who has easy access and can change the behavior and
look of almost everything. The competing GNOME desktop takes inspira-
tion from both Windows and Mac OS X and sets a priority on simplicity
and ease of use. GNOME is also easy to customize, but the less common
options are either eliminated or well hidden to prevent user overload.
Luckily, Ubuntu users are blessed with the choice of either desktop, along
with several others, some of which are mentioned in Chapter 10. The
default desktop in Ubuntu is GNOME, and the Kubuntu distribution uses
the KDE desktop. Kubuntu is covered in Chapter 8.

In this chapter, we help you get started with GNOME and show how you
can use it to do the normal things you face every day with your computer
and a few not-so-normal things. This includes opening and running
applications, managing your files, adjusting the look and feel, using appli-
cations, managing your media, and more. Buckle up and get ready to take
your shiny new desktop for a drive!
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TIP The Ubuntu Desktop Is GNOME
When reading about Ubuntu, you often see the terms Ubuntu desktop and GNOME used
interchangeably. Both of these terms refer to the same thing—the default Ubuntu desktop is
a version of GNOME itself. Of course, Ubuntu provides several other desktops, including
KDE (in Kubuntu), Xfce (in Xubuntu), and a variety of others.

Taking Your Desktop for a Ride
When you start your Ubuntu system, you are presented with a list of users.
Once you select your username from the list by clicking it, you are asked
for a password to log in with. In the last chapter, you specified a user
account when installing the system, so use that to log in. First type in your
username and press Enter, then your password and press Enter.

After a few seconds you will see the Ubuntu desktop appear (Figure 3-1).
The desktop has three main areas.

1. At the top of the screen is the panel. This bar contains the desktop
menu options and application shortcut icons on the left side as well as
the notification area on the right side. You use this bar to load
applications and to see the status of certain activities on your system.
The panel is always visible when you use your desktop.

2. The large middle part of the screen, located under the panel, is the
desktop. This part of the screen is normally covered by the applica-
tions that you use, but you can also put icons and shortcuts on the
desktop, too.

3. The bottom part of the screen is called the taskbar. This area displays
a rectangle for each open application, just like in Windows.

You may have noticed that, unlike other operating systems, there are no
icons on the desktop. The reason for this is that desktop icons typically get
covered by applications, and, as such, you can’t get at them. If you need to
start applications, you typically use the Applications menu or the shortcuts.
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TIP Device Icons
Although there are no application icons on the desktop, when you plug in USB devices such
as portable music players, keyring drives, or digital cameras, a device icon will appear on the
desktop.

Starting Applications and Finding Things
Starting applications is simple. Just click on the Applications menu on the
left side of the panel. Inside this menu are a number of submenus for dif-
ferent types of applications. Hover your mouse over each category, and
then click the application you want to load. As an example, click on Appli-
cations > Games > Mahjongg. 

When applications are loaded, the window border has three buttons on
the top on the left-hand side:
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Figure 3-1 The Ubuntu desktop is simple, uncluttered, and . . . beautiful.



� Left button (red button with a black X): This button closes the
application.

� Middle button (white button with a gray ˇ): This minimizes the
application, taking it off of your screen, and puts it in the taskbar for
easy access when you need it again.

� Right button (white button with a gray ^): This is used to maximize
the window to take up the full desktop area.

Every application that is in use has an entry in the taskbar at the bottom of
the screen. You can click these entries to minimize or restore the application
to or from the taskbar, and you can right-click to see some other options.

Finding Your Files and Folders
When using your computer, you often need to save and open files and fold-
ers, move them around, and perform other tasks. The Places menu con-
tains a bunch of entries, including those listed here, to access different parts
of your computer and the network. 

� Home Folder: Your home folder is used to store the files and work for
each user who is logged in. This is the most important folder on the
system, and you can think of it as the equivalent of My Documents in
Windows—virtually everything you save lives here. Each user has a
separate home folder.

� Desktop: The Desktop folder is inside your home folder and contains
files that visually appear on your desktop as icons. If you drag a file
onto your desktop, it will appear in the Desktop folder. Similarly,
moving a file out of this folder or deleting it will remove it from your
desktop.

� Computer: Clicking this item displays the different drives attached to
your computer as floppy drives, CD/DVD drives, and USB keys or
sticks. This is the equivalent of the My Computer icon in Windows.

� Network: This option accesses all networked and shared devices, such
as file servers or printers, that are available on your local network.
This is the equivalent of the Network Neighborhood or Network
Places in various versions of Windows.
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� Connect to Server: Click this to run a wizard to create a connection
to a network server. You can use this to add an icon to the desktop
that, when clicked, provides a list of remote files in the desktop file
manager. You can then treat this window like any other file manager
window and drag files back and forth. This is really useful for copying
files to other computers.

� Search for Files: Use this to search for files on your computer.
� Recent Documents: Click this submenu to display the most recently

used documents.

Configuring Your System
The third and final menu, System, is used to configure and customize your
system, access help, and report problems. Inside the menu are a few options,
including these:

� Preferences: This submenu contains items for customizing the look
and feel of your desktop. Each of these settings applies only to the
desktop of a user who is logged in. If you log in as another user, the
settings change to that user’s preferences.

� Administration: This submenu is used to configure systemwide
settings such as networking, users, printing, and more. To use these
menu items, your account must have system administrator privileges,
and you must know and use your password.

� Help and Support: With this you can access the Ubuntu Help Center,
which provides documentation and guides for your Ubuntu desktop.

� About GNOME: Here you have a simple, animated document with
information and links about GNOME.

� About Ubuntu: This brings up a detailed document, with links, that
helps users learn more about Ubuntu.

TIP Feel the Power
When you installed Ubuntu, you were asked for a username and password for the system.
That first user account (and its password) has access to not just your normal user account
but also the all-powerful Administration features. Therefore, when you access the menu
options while using this account and are asked for a password, just enter this user account’s
password to use those features.

This feature applies only to the user account created during installation. If you add other
users, you need to explicitly allow them access to Administration options.



Adding Additional Users
Many computers these days are used by more than one person. Rather than
forcing everyone to use the same desktop settings or making the computer
less secure by allowing everyone who uses it to have access to administrative
functions, it is easy and recommended to create an account for every per-
son who will use the computer. This allows each user to customize how the
computer works and looks without interfering with anyone else’s prefer-
ences, and it grants the administrator privileges that prevent others from
accessing functions that may affect everyone or even damage the installa-
tion if used incorrectly.

Adding a new user is done by clicking System > Administration > Users and
Groups. In the dialog box that appears, there is a list of current users. At the
bottom of the list, select Add to create a new user account, as in  Figure 3-2.

A password is required to make changes to users and groups, and only those
users with administrative access are able to do so. You must now provide a
name for the new user as well as a short name that will be used by that user
to log in. Click OK, and in the next dialog box, enter a password for that
user, confirm the password by entering it a second time, and click OK
again. Voila, our new user account is created. You may also have a password
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 generated randomly or allow the user to log in without a password. This last
option is not generally a good idea but can be useful. For example, if the
users are small children who are not expected to perform administrative
tasks, the children could have an account that automatically logs in at boot
time, and the administrator would have an additional account, accessed by a
password, to perform changes and updates when necessary.

Finally, now that the account is created, we may customize its settings.
Highlight the username in the list, and click the Change button at the right
next to Account Type for a speedy way to give the user administration priv-
ileges. The Advanced Settings button from the lower right corner of the
dialog box may be used to set contact information for the user, change the
account’s user privileges (for example, giving access to administrative and
several other functions that are not available through the quick change
option), and even change the location of the account’s home directory. Be
careful when using this power because an account can be damaged or ren-
dered inaccessible if things are not done properly.

Shortcut Icons
On the panel are a number of shortcut icons next to the menus. These
small icons are always visible and can be single-clicked to gain immediate
access to your favorite applications. Ubuntu comes with several stock
shortcuts on the panel, but you are welcome to add your own or remove
the defaults as you like.

Adding your own icon is as simple as finding the application you want to
add in the menu and then dragging it to the panel. You can then right-click
the new shortcut icon and select Move to move it to the desired spot on the
panel. You can also do this in the menu by right-clicking on a specific pro-
gram’s entry and choosing the option to have a launcher for the program
to be added to the panel. You may have to click to unlock the item from the
panel first, which may be done from the same menu.

Applets
One simple yet powerful feature in Ubuntu is the ability to run small pro-
grams called applets on the panel. These small programs are useful for a
variety of tasks and provide quick and easy access via the panel.



To add an applet, right-click the panel and select Add to Panel. The win-
dow shown in Figure 3-3 pops up. Select one of the many applets, and click
Add. When the applet appears on the panel, you can press the middle
mouse button (or the left and right buttons together) to move it around.

The Notification Area
In the right-hand part of the top panel is the notification area and the
clock. The notification area is similar to the Windows system tray in that it
provides a series of small icons that indicate something specific. A good
example of this is Network Manager, which looks after your network con-
nections—both wired and wireless—for you.

You can adjust the notification area items by right-clicking them to view a
context menu. Some icons (such as the volume control) allow you to left-
click on them to view them. As an example, try clicking the little speaker
icon and adjusting the slider.

QUICK TIP Left-click the volume icon and select Sound Preferences to access a large number of sound
settings. These settings configure the speakers, microphone, line-in, any other sound card
inputs or outputs, and more.
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Figure 3-3 Ubuntu comes bundled with a selection of applets.



Three applets are installed by default: the previously mentioned sound
applet, the indicator applet, and the network manager applet. The indicator
applet tells the user when something needs attention on the desktop and
provides quick access to communication options like Empathy, Evolution,
and Gwibber with a left-click (more on these later in the chapter). The net-
work manager applet (Figure 3-4) gives easy access to networking controls.

Network Manager
Network Manager is a network interface created to help you manage your
network devices and connections and is accessed using the network man-
ager applet. The goal is to make networking “just work” easily and without
requiring users to know how to hand-configure the settings (although that
is still available for those who want to do so). A left-click of the mouse on
the applet shows you the dialog box and enables quick changes between
network types. It even provides an easy way to set up access through a vir-
tual private network (VPN), such as many of us are required to use to
access files from work or school securely. A right-click lets you enable or
disable both wired and wireless networking, enable or disable notifications,
see information about your current connection, and edit connections
quickly and easily (Figure 3-5).
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Figure 3-4 The network manager applet, left-clicked to show available wireless
networks

Figure 3-5 The network manager applet, right-clicked to show connections menu



The Clock
Next to the notification area is the clock. Click on the clock to view a calen-
dar. Later, when you use Evolution, items that are added to your calendar
appear in the clock applet too. Instead of opening up Evolution to find out
when your dentist appointment is, just click on the clock to see it immedi-
ately. More information about Evolution is contained later in this chapter.

QUICK TIP Customize your clock by right-clicking it and selecting Preferences.

The Taskbar
The taskbar sits at the bottom of the screen. This small bar is always visible
and indicates which applications are currently open. In addition to this,
the taskbar also sneaks in a few other handy little features.

To the far left of the taskbar is the Hide/Show Desktop button. Clicking
this button hides all of your open applications and shows the desktop.
Clicking it again redisplays them. This button is useful when you need to
quickly access something on your desktop.

Next to this button is the applications area, which shows each of the cur-
rently open applications. For each application, an entry is added, and you
can right-click it to view a context menu. This menu can also be used to
minimize, maximize, resize, close, and otherwise control applications.

QUICK TIP You can switch between multiple applications in Ubuntu just like in Windows by pressing
Alt-Tab. When you press this key combination, a small window appears that can be used to
switch between active applications.

To the right of the applications area are two small rectangles called the work-
spaces. Each of these rectangles represents another screen in which you can
view an application. As an example, you may be using your Web browser
and e-mail client while talking to your friends in a chat client on the first
desktop and working on a document on the second desktop. You can then
just click each virtual desktop to switch to it to access your different applica-
tions. Another useful tip applies when you’re moving applications between
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virtual desktops—if you have an application on the first desktop, just right-
click the charcoal-colored window or the taskbar entry, select Move to
Another Workspace, and pick the relevant workspace number. The menu
also has Move to Workspace Left and Move to Workspace Right options.
This makes moving applications between your workspaces quite simple.

QUICK TIP Although Ubuntu has only two workspaces configured by default, you can have as many—
or few—as you like. To configure them, right-click on one of the workspaces in the bottom
right-hand corner of your screen, and select Preferences from the menu.

To the right of the workspaces is the trash. Files dragged onto this icon or
right-clicked and “moved to trash” are destined to be deleted. To fully
delete these files, right-click the trash and select Empty Trash.

TIP Usability and the Ubuntu Desktop
Throughout the development of the Ubuntu desktop, great care and attention have gone into
usability. As an example, the four corners of the screen are established as areas that are
simple to access—you don’t need to carefully mouse over the area and can instead just
throw your mouse to the corner. This is why each corner has an important feature. It makes
accessing each feature that little bit easier.

Ubuntu is filled with tiny usability improvements such as this that help make it as intuitive
and powerful as possible. Canonical has created a collective project called Ayatana to spear-
head this development, which has already produced the lovely indicator applet and is working
on greater refinements and features. More on Ayatana can be found at https://wiki.ubuntu.
com/Ayatana.

Shutting Down Your Computer and Logging Out
Now that you’re becoming acquainted with Ubuntu, you’ll want to keep
using it as long as possible, but there will always come a time when you
have no choice but to leave your computer and go do something else. As
you have already seen, Ubuntu is extremely flexible, and this area is no
exception. Click the icon in the top right of the screen to see the various
options (shown in Figure 3-6) for ending your current computing session.

A number of options are available upon logout; however, the choices pre-
sented to you will depend on your installation (e.g., Suspend may not be
available).

https://wiki.ubuntu.com/Ayatana
https://wiki.ubuntu.com/Ayatana


� Lock Screen: This option locks the screen, which is useful when you
need to use the bathroom or grab some lunch. It locks the computer
and asks for your password to reenable the desktop.

� Guest Session: This option lets you allow someone else to use your
computer while keeping you logged in but your data and account
secure by giving the guest a limited desktop to work with temporarily
and requiring your password to return to your desktop. 

� Switch from . . .: Your username will be listed here. This option takes
you to the login screen and lets you switch between logged in users
without logging anyone out. It also requires each specific user’s
password to access his or her account.

� Log Out: This option lets you log out of the current session and go
back to the main login screen.

� Sleep: If your computer supports it, this option will be included in
the list, and you can click it to save the current state of your system in
RAM. The next time your computer is turned on, the desktop will be
resumed. This option continues to use battery power but only a
minimal amount.

� Restart: Click this to restart the computer.

� Shut Down: Click this to shut down your computer.
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Figure 3-6 Ahh, the possibilities. . . .



Using Your Applications
Now that you have become familiar with the desktop, let’s explore some of
the many applications included on your new system. By default, Ubuntu
comes with a wide range of popular and established applications to listen
to music, watch videos, create documents, browse the Web, manage your
appointments, read your e-mail, create images, and much more. These
applications have been vetted by the developers to ensure they are the best-
of-breed Linux applications available.

Although Ubuntu includes a range of software applications, it is likely you
will want to install extra applications and explore other available software.
Fortunately, the Ubuntu system is built on a powerful foundation that
makes software installation as simple as pointing and clicking in the Ubuntu
Software Center, covered in depth in Chapter 4. Just browse through the dif-
ferent categories and check the applications to install. Click the Apply but-
ton, and the application is downloaded and installed for you.

This tool provides a simple way to access a limited core set of popular appli-
cations, but there are actually more than 30,000 packages available to your
Ubuntu system. Software installation is discussed in detail in Chapter 4.

TIP Another Way to Run Applications
Although you will most typically start your applications by selecting them from the Applica-
tions menu, you can also press Alt+F2 (on Mac hardware, use Fn+Alt+F2) to bring up a box
where you can type in the name of an application and run it.

Browsing the Web with Firefox
Firefox is the default Ubuntu Web browser and provides you with a
simple, safe, and powerful browsing experience. Firefox is developed by
Mozilla and has become one of the most successful open source projects in
the world and continues to garner huge popularity. With hundreds of mil-
lions of downloads and rapidly increasing browser share, Firefox has been
an unparalleled success.

QUICK TIP You can learn more about Mozilla and Firefox, as well as their other software products, at
www.mozilla.org.
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Fire up Firefox by clicking its icon (the first one next to the System menu)
on the panel or by selecting Applications > Internet > Firefox Web Browser.
Before long, you’ll be presented with the main Firefox window (Figure 3-7).

The Firefox window looks similar to most Web browsers and includes the
usual back, forward, reload, and stop buttons, an address bar, and some
menus. These familiar-looking elements help you become acquainted with
Firefox, and if you have used Internet Explorer, Opera, Chrome, or Safari
before, you are sure to pick it up in no time.

Navigating your way around the Internet is no different in Firefox than in
any other browser—just type the Web address into the address bar and
press Enter. Firefox also has a few nice features that make it easy to access
your favorite sites. As an example, if you want to visit the Ubuntu Web site,
you can just enter www.ubuntu.com (leaving off all that http:// nonsense).
Alternatively, you can just type in “Ubuntu,” and Firefox will do the equiv-
alent of going off to Google, entering “Ubuntu” as the search term, and
taking you to the first result for the search. This feature is incredibly handy
for popular sites that are likely to be at the top of the search results page.

Figure 3-7 The Firefox interface is sleek but extensible.

www.ubuntu.com


TIP The search box next to the address bar can be used to do searches. By default, these
searches are on Google. To do a Google search, just type in your search term and press
Enter. You can also click the down arrow next to the Google logo and select from a variety of
other sites to search, including sites like Amazon.com and Wikipedia.

This search box can be used to search just about anything. To add more search engines,
click the small icon and then select Manage Search Engines.

Bookmarking Your Favorite Sites  To bookmark the page you are viewing,
click Bookmarks > Bookmark This Page or click Ctrl+D. In the dialog box
that pops up, use the combo box to select the folder to store the bookmark in.
You also have the option to add “tags” to your bookmark, which are like key-
words that can be used to sort and search for your bookmarks in the future.
When you have finished naming and tagging your bookmark, click Done to
save the bookmark.

Save Time with Live Bookmarks  Firefox also includes a special feature
called live bookmarks that automatically grabs content from a Web site with-
out your needing to visit it. As an example, go to http://fridge.ubuntu.com (a
popular Ubuntu news site), and you will see a small orange icon—which
indicates that this site has a feed available—on the right side of the address
bar. Click this orange square, and you will be taken to a new page that pre-
views the feed and gives you the option of what you would like to use to sub-
scribe to it. Use the default option (Live Bookmarks), and click Subscribe
Now. A dialog box will pop up. Use the default values provided and click OK.
A new toolbar button is added, and when you click on it, a list of the items
from the Web site are displayed. Each time you start Firefox, it will quietly go
away and update this list so that you don’t need to visit the site yourself. The
“Latest Headlines” toolbar entry is an example of this.

TIP If You Liked the Fridge
You may also like Planet Ubuntu at http://planet.ubuntu.com. This site collects the personal
blogs of a number of different Ubuntu developers and other community members. Planet
Ubuntu gives a unique insight into what the developers are working on and/or interested in.

Bolt It On, Make It Cool  Although Firefox is already a powerful and flexible
Web browser, it can be extended even further using special plug-in exten-
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sions. These extensions cover not only typical browsing needs but also other
more specialized extras that extend the browser itself.

To install normal Web plug-ins, just visit a site that requires the plug-in. A
yellow bar will appear at the top of the page, indicating that you are miss-
ing a plug-in necessary to fully take advantage of the page you are visiting.
Click the Install Missing Plug-ins button to grab the required plug-in. For
example, Ubuntu does not come with the Macromedia Flash plug-in
because it does not live up to Ubuntu software freedom requirements. As a
result, you will have the option to install either Macromedia Flash or the
free software version Gnash if you want to use Flash.

To extend the browser itself with additional features, go to https://addons.
mozilla.org and browse for an extension that you are interested in. When
you find something you would like to install, click the Install link. A dialog
box will pop up asking you to confirm the installation. Click Install Now.
Your new extension will now download and install automatically. Typi-
cally, this requires a restart of Firefox, and then your extension is available.

TIP Be Careful Where You Download
It is recommended that you download extensions only from http://addons.mozilla.org. If you
do need to install an extension from another site, make sure it is a site you trust. Otherwise,
the extension may contain unsafe software, viruses, or spyware.

Creating Documents with OpenOffice.org
Included with Ubuntu is a full office suite called OpenOffice.org. This
office software comes by default with applications for word processing,
working with spreadsheets, and presentations. Adding other features,
such as the ability to create and manipulate databases, work with draw-
ings, and more, are easily installed later. The suite provides an extensive
range of functionality, including reading and writing Microsoft Office file
formats, and can also export documents as Web pages, PDF files, and even
animations.

Let’s give OpenOffice.org a whirl by creating a letter with it. Start Open -
Office. org word processor by selecting it from the Applications > Office

https://addons.mozilla.org
https://addons.mozilla.org
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menu. When it has loaded, you will be presented with the interface shown
in Figure 3-8.

If you have used a word processing program before, many of the common
interface elements, such as the buttons for setting font type and size, bold,
italic, underline, and alignment, look and behave the same. The OpenOf-
fice.org developers have designed the suite to be easy to migrate to if you
have used a program like Microsoft Office before. After a few minutes
playing with OpenOffice.org, you will be confident that you can find the
functions you need.

Start your letter by first choosing a nice font. In the font combo box, you
should see Liberation Serif (which is a free-as-in-liberty font similar to
Times) selected as the default. You can click the box and choose another if
you prefer, such as the lovely DejaVu Sans font. Change the font size by
clicking the combo box to the right of the font box and selecting 10 as the
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Figure 3-8 OpenOffice.org looks similar to Microsoft Office and is therefore quite
simple to adjust to.



size. With the cursor on the left side of the page, add your home address to
the letter.

Now press Enter to leave a blank line under the address, and click the Align
Right toolbar button (the icon looks like some lines aligned to the right). If
you are unsure of what a button does, hover your mouse over it to pop up
a tool tip. Now add to your letter the address of the recipient.

Press Enter again to leave a blank line, and type the main body of the letter.
Feel free to use the bold, italic, and underline buttons to add emphasis to
your words. You can also use other toolbar buttons to add items such as
bullet points and numbered lists and to change the color of the font. If you
want to add features such as graphics, tables, special characters, and frames,
click the Insert menu and select the relevant item. You can customize each
item added to the page by right-clicking the item and using the options
shown in the context menu.

When your letter is complete, you can save it by selecting File > Save, by
clicking the floppy disk toolbar icon, or by pressing Ctrl-S. The default file
format used by OpenOffice.org is the OpenDocument Format. This file
format is an official open standard and is used across the world. The
file format is slightly different for different types of applications (.odt for
word processor files, .ods for spreadsheets, and so on), but each format pro-
vides an open standard free from vendor lock-in. You can also save in a
variety of other formats, including the default formats for Microsoft Office.

TIP Vendor Lock-In?
In the proprietary software world, it is common for each application to have its own closed
file format that only the vendor knows how to implement. When a person uses the software
to create documents, the closed format means that only that specific tool can read and write
the format. As long as you want to access your documents, you need that tool. This is
known as vendor lock-in.

To combat this problem, the OpenOffice.org suite (and the vast majority of other open
source applications) uses an open file format that is publicly documented. In fact, the format
is a published standard under ISO/IEC 26300:3006. This means that other applications can
implement the OpenDocument file format, and you can be safe in the knowledge that your
documents will always be available and you are not locked in to any specific tool.
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Another useful feature wedged into OpenOffice.org is the capability to
save your documents in the Adobe PDF format. PDF files have been
increasingly used in the last few years and are useful for sending people
documents that they should not change (such as invoices). PDF files pro-
vide a high-quality copy of the document and are well supported across all
operating systems. This makes PDFs ideal for creating catalogs, leaflets,
and flyers. To save a document as a PDF file, click the PDF button on the
main toolbar (next to the printer icon). Click the button, enter a filename,
and you are done. Simple.

Connecting with Empathy and Gwibber 
and the Indicator Applet
Empathy is a chat program that can interact with Google Talk, AIM, Win-
dows Live, and many other chat programs. It has audio and video capabil-
ity as well. You can get started by left-clicking the indicator applet (it looks
like an envelope) on the top panel and choosing Chat. You will then be
given an opportunity to enter your account information for various
services and to begin communicating.

Gwibber, listed in this menu as Broadcast, is accessible from the same loca-
tion and can be set up to allow you to integrate online services like Flickr,
Twitter, identi.ca, and Facebook into your desktop for even easier access to
what is happening in your social networks. Open it, enter your account
information as directed, and you can begin to interact with all your circles
from one location on your desktop.

On the top panel, you may have noticed your username with a speech bal-
loon icon next to it. This location gives you a convenient place to mark
yourself available for chat or away, update your information for social
accounts that use either Empathy or Gwibber, and use your Ubuntu One
services.

Ubuntu One
Ubuntu One is an online cloud storage application that is free for any
Ubuntu user. This enables any user to create an Ubuntu One account and
store up to 2GB on remote servers (more space is available for a fee) that
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may be accessed from anywhere. The service is built in to the Ubuntu
desktop and, once activated, integrates smoothly. You can get started con-
figuring your account from the menu at System > Preferences > Ubuntu
One. More information is available at one.ubuntu.com.

Managing Your E-mail and Calendars with Evolution
Evolution is modeled around the all-in-one personal information man-
agement tool. Within Evolution you can read your e-mail, manage your
schedule, store contact details, organize to-do lists, and more in a single
place. This makes Evolution useful for both businesspeople and regular
users who want easy access to this information.

Setting Up Your E-Mail Account  To use Evolution to read your e-mail, you
need to find out the following settings for connecting to your e-mail server
(you can get these details from your ISP or system administrator):

� Your type of e-mail server (such as POP or IMAP)

� Your mail server name (such as mail.chin.com)

� Your mail account’s username and password

� Authentication type (typically by password)

� Your outgoing mail server type (typically SMTP)

� Your outgoing mail server name

To use Evolution for just the calendar function, you need to go to the indi-
cator applet (looks like an envelope) in the notification area on the top
panel and click on Set Up Mail. In a few seconds, the Evolution Setup
Assistant window will pop up. Here are the necessary steps:

1. On the Welcome screen, click the Forward button.

2. Next, you may restore your e-mail from a backup, but since we are
doing a fresh setup, click the Forward button.

3. On the Identify screen, enter your full name and e-mail address in the
appropriate boxes. Under Optional Information, you should uncheck
the Make this my default account box. Then click the Forward button.
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4. In the Receiving Email dialog box under Configuration > Server, just
add your name. You can add your name under Username as well.
Then click the Forward button.

5. On the Receiving Options screen, click the Forward button.

6. On the Sending Email and Server Configuration screen, add your
name here as you did in earlier steps.

7. In the Account Management dialog box, just click the Forward button.

8. On the Done screen, click the Forward button.

9. Finally, once Evolution opens, click New Icon (looks like a clock), and
from the drop-down menu, select Calendar.

10. When the New Calendar window pops up, you can pick which type of
calendar you want to use. Note: If you don’t already have another type
of calendar, just leave the Type as CalDAV, then fill in the name—this
will be the name of your calendar. Pick the color you want your
events to show up as, then click Mark as default calendar.

If you are using Google calendar, you can also add this function to your
calendar. All the steps are the same, but when you get to step 10 to add a
new calendar, you need to choose Google as the type of calendar. Then fill
in the name you want to use for the calendar, choose the color, and mark it
as your default calendar. You probably want to copy the contents locally,
too, in case you need to access it when you do not have Internet access.
When you click Google, you will see a Username field show up under
Name. Your username should be your gmail name, but without the
“@gmail.com.” Once you enter your username, click on Retrieve List. You
will be prompted to enter your gmail password. Enter it. When the Enter
Password window goes away, you should see a list of calendars that you
have linked to your Google calendars. If you have more than one Google
calendar you want to add, then just pick which one will be your default
calendar. Repeat step 10 for each calendar you want to add.

TIP Evolution and Webmail
You can’t use Evolution to read Webmail such as Yahoo! Mail or Hotmail unless you configure
your Webmail to allow POP access and to use SMTP to send e-mail. Consult your Webmail
provider for more details on if and how you can access the mail with a local client like Evolution.



Load Evolution by clicking the envelope and clock shortcut icon from the
panel (hover your mouse over the shortcuts to see what they are) or by
clicking Applications > Internet > Evolution Mail. When the application
loads, you are taken through a wizard to set up your e-mail server (as
shown in Figure 3-9).

Click Forward to continue the setup, and after choosing to not restore
from a backup, you will be asked for your identity. Fill in your e-mail
address in the E-Mail Address box, and add the optional information if
you want to. The additional details are not essential for using Evolution.
Click Forward to continue.

You are next asked to choose what kind of e-mail server you have from the
drop-down box. When you make your selection, some additional settings
are displayed. Fill in the server name and the username. You may need to
adjust the Security and Authentication Type settings, but for most
accounts the default settings should be fine. Click Forward to continue.
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Figure 3-9 Setting up Evolution is simple as long as you know the details for your
mail server.
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The next page configures some options for receiving your e-mail. None of
these options are essential, although you may want to check the first box to
automatically check for new mail. Click Forward to continue. The next
screen configures the settings for sending e-mail. In the combo box select
the Server Type (typically SMTP) and add the server name to the Server
box. Click Forward to continue.

In the next screen, enter a name to describe the account. The default entry
(your e-mail address) is fine, but you may want to add something more
meaningful such as “Work E-Mail” or “Home E-Mail.” When you have
added this, click Forward to continue. Finally, select your location from the
map. If you click on your area of the world, the map will zoom in. Once you
have done this, click Apply to complete the process and close the wizard.

With the wizard completed, the main Evolution interface will appear, as
shown in Figure 3-10.

Figure 3-10 Those of you who have used Microsoft Outlook should find the
interface very similar.



On the left sidebar you can see a number of buttons to access the mail,
contacts, calendars, memos, and tasks components in Evolution. When
you click each button, the interface adjusts to show you the relevant infor-
mation about that component.

Working with Your E-Mail Inside the e-mail component you can see the
e-mail folders in the left panel and the list of messages in the top pane.
When you click on a message, it is displayed in the bottom pane, where
you can read it. With your new account set up, you will first want to go and
grab the e-mail from your mail server. Click Send/Receive, and the mail is
retrieved from your server and any unsent mail is sent.

TIP Problems?
If you cannot connect to your mail server, there may be an error in your account configura-
tion. To edit your account settings again, click Edit > Preferences, select the account from
the list, and click Edit.

With your messages loaded, new e-mails are shown in bold in the top pane.
Move through the different e-mails using the up and down arrow keys, and
each message will be displayed. You can reply to a message by clicking the
Reply or Reply To All toolbar buttons. New e-mails can be created by click-
ing the New toolbar button. By default, new e-mails and replies are sent
automatically when you click the Send button in the compose window.
This way you don’t need to click the Send/Receive button to deliver them.

Managing Your Calendar  Inside calendar mode, Evolution provides
another convenient way to manage your schedule, add new events, and
view your calendar in different ways. When you click the Calendars button
to switch to this mode, you can see the timetable for today as well as the
month view. The month view shows a couple of months in which the bold
dates have events.

You can add two types of events to your calendar.

� Meetings: These are events with a specific group of people.

� Appointments: These are general events. 

Using Your Applications 83



84 Chapter 3 � Using Ubuntu on the Desktop

To add a new appointment, navigate to the date you require using the cal-
endar, then right-click a time slot in the day view, and select New Appoint-
ment. Alternatively, simply click the New toolbar item. In the box that
pops up, fill in the Summary, Location, Time (adjusting the date if neces-
sary), and Description boxes. You can also select which calendar the event
appears on if you have multiple calendars configured.

TIP Multiple Calendars
Evolution supports multiple calendars. This is useful if you want different calendars for dif-
ferent types of events such as personal and work-related activities. To create a new calendar,
right-click the calendar list in the left sidebar and select New Calendar.

To add a new meeting, again find the date, right-click the day view, and
select New Meeting. Inside the dialog box that pops up, you need to add
the participants who are attending the meeting. You can add participants
in two ways: Use the Add button if they are not in your address book, or
use the Attendees button if they are in your address book.

When you click Attendees, a new dialog pops up with a list of attendees
down the left. You can use the Add and Remove buttons to add contacts to
(or remove them from) the different categories of Chairpersons, Required
Participants, Optional Participants, and Resources. Now, you probably
don’t have any contacts in there, as you are just starting to use Evolution,
so use the main Contacts button on the left side of the main Evolution
window to add some.

You can view your calendar in lots of different ways by clicking the differ-
ent toolbar buttons such as Week, Month, and List. Play with them and see
which ones are most useful to you.

QUICK TIP Remember, you can access your appointments without opening Evolution by clicking on the
clock in the panel.

The Ubuntu File Chooser and Bookmarks
One area in which the GNOME developers have worked hard is in creat-
ing an intuitive and useful file chooser that is accessed in applications



with File > Open. The window that pops open is called the file chooser.
You may be wondering why they have spent so much time on such a small
and seemingly insignificant part of the desktop. In reality, however, find-
ing files is one of the most frustrating aspects of using computers and
often involves digging through folder after folder to find what you need.
Luckily, the GNOME file chooser (Figure 3-11) helps cut down much of
this file hunting significantly.

The listing of files on the right-hand side is used to find the file you need,
and you can click on folders in this listing to traverse deeper into your sub-
folders. Note how each folder is displayed above the listing in a series of
buttons. You can click these buttons to easily jump back to parent folders
when needed.

Aside from enabling you to manually pick files, the chooser also supports
bookmarks. On the left side of the chooser is a list of devices and bookmarks
labeled Places. These include your home directory (shown as your user-
name), Desktop (the files on your desktop), and File System (the entire hard
drive), as well as devices such as CD drives, floppy drives, and USB sticks.
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Figure 3-11 The file chooser makes it easy to find what you want.



To create your own bookmark, use the listing on the right to find the folder
that you want to bookmark, single-click it, and then click Add below the
Places box. You could also right-click on the file and choose Add to Book-
marks. The folder now appears in your bookmarks. Now whenever you
need to access that folder, just click the bookmark! In addition to putting
the bookmark in the file chooser, it is also available in other parts of the
desktop, such as the Places menu and in the file manager.

Ubuntu in Your Language
When you installed Ubuntu, you were asked which language the system
should use. Although this sets the initial language for the system, you may
want to change the language at a later date. To do this, click System >
Administration > Language Support.

Ubuntu supports a huge range of different languages, and many applica-
tions include a Translate This Application menu option in the Help menu
so that all Ubuntu users can contribute translations in their language(s). If
you would like to help with this effort, it is a fantastic contribution to the
Ubuntu project.

When the language selector first loads, it may ask you to update your lan-
guage packs. Just click Yes to continue. Inside the dialog box a number of
languages are listed, each of which has a Support checkbox listed next to it.
For each language that you want available on the system, check the rele-
vant boxes.

When you have selected the boxes, click the Apply button, and the appro-
priate language packs are downloaded and installed. Now use the Default
Language combo box to choose the new language. You need to log out and
log back in for the changes to take effect.

TIP Choosing a New Language
When you see the login screen, you can use the Language button to choose a language for
that specific login session. When you select the language, you are asked if you want to make
it the default language or use it just for that specific session.
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Customizing Ubuntu’s Look and Feel
Whenever we put someone in front of Ubuntu for the first time, there
seems to be a uniform natural desire to tweak the look and feel of the desk-
top. It can be fun tweaking our desktops so they look just right, and
Ubuntu has great support for all kinds of adjustments. Do you want dif-
ferent-looking applications with a lime green background and crazy fonts?
No problem; just don’t show it to anyone else. . . .

Changing the Background
To change the background of your desktop, right-click it and select
Change Desktop Background. Inside the dialog box that appears, choose
your wallpaper by clicking on an image, and the desktop background will
automatically change. Ubuntu comes with a limited range of preinstalled
wallpapers, so it is likely that you will want to add your own wallpaper. To
do this, save your wallpaper somewhere on your computer, and then use
the Add Wallpaper button to select it. The new wallpaper can be selected
from the list.

If you are not really a wallpaper kind of person and would prefer just a
color for the background, you can use the Desktop Colors controls at the
bottom of the dialog box. The combo box provides three different types of
background: Solid Color, Horizontal Gradient, and Vertical Gradient. Next
to the combo box, click on the color chip to select the relevant color(s).

Changing the Theme
When you are using your applications, the visual appearance of the but-
tons, scroll bars, widgets, and other bits and pieces are controlled by the
theme. The built-in theming system can make your applications look radi-
cally different, and Ubuntu ships with a number of themes that you can try.

Choosing a New Theme  To choose a new theme, click System > Prefer-
ences > Appearance and then click on the Theme tab. Inside the tab that
pops up are a number of themes that you can choose. Just click on a
theme, and the desktop will be adjusted automatically. You can further
customize your theme by clicking the Customize button. A new dialog box
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appears that has tabs for the different parts of the theme you can config-
ure. Click each tab, and select an entry from the list to create your own
perfect theme.

Installing New Themes  To install a new theme, head over to http://
art.gnome.org and find a theme that you like. You can do this directly from
the Theme tab in the System > Preferences > Appearance window men-
tioned previously by clicking Get more themes online. You need to look
for Controls and Borders when browsing under the Themes tab on the
site. When you find a theme that you like, download it to your computer.
Now Click System > Preferences > Appearance, and click the Install button
in the Theme tab. Using the file chooser, find the theme that you just
downloaded, and it will install automatically. You may now select your
new theme from the list.

Configuring a Screensaver
To choose a different screensaver, click System > Preferences > Screen-
saver. The screensaver configuration tool then loads (Figure 3-12).

Figure 3-12 A number of screensavers are bundled with Ubuntu.

http://art.gnome.org
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On the left side of the window is a list of available screensavers. Click on a
screensaver and you will see a preview appear in the space to the right of
the list. You can then use the slider to select how long the computer needs
to be idle before the screensaver kicks in.

The Lock Screen When Screensaver Is Active checkbox can be selected to
lock the screen when the screensaver starts and, as such, requires a user to
enter the password to reactivate the desktop. This is useful if you work in
an office and want to ensure that no one tampers with your computer
when you are away.

Managing Your Files
Files are the primary components of any computer use, and they need to be
managed, copied, moved, renamed, grouped, and loaded. Included with
Ubuntu is a powerful yet simple file manager called Nautilus that integrates
tightly into your desktop. You’ll use it all the time even if you don’t often see
that name. Most often, you will see it referred to as File Browser.

File Browser makes extensive use of drag and drop. Unlike the kind of file
manager used in Windows with its tree view and listing of files, File Browser
displays files in a series of windows in which you can drag files around easily.
For those who just can’t say goodbye to the tree view, File Browser also sup-
ports that. Aside from providing a simpler user interface, File Browser also
includes a number of useful features such as video and image previews,
emblems, bookmarks, permissions management, and more.

You can start File Browser from a number of different places, but the easi-
est way to launch it is from the Places menu. Click on Places > Home
Folder to load your home folder. When the folder loads, you should see
something similar to what Figure 3-13 shows.

The File Browser window is split into two parts. The sidebar shows cate-
gories of information such as bookmarks, folders, emblems (more on
these later), and more. In the main part of the window, you can see the
subfolders and files in the current folder. By default, File Browser displays
your bookmarks in the left sidebar and displays the contents of your
home folder.
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So, let’s play with File Browser and see what you can do with it. The first
important skills to learn involve general file management. Many of the
tasks you need to do can be achieved by right-clicking your file/folder and
selecting the relevant option. There are also a number of options in the
Edit menu.

First, create a folder by right-clicking the main part of the window and
selecting Create Folder. A folder is added, and you can type in the name of
it. If you change your mind about the name, rename it by right-clicking
and selecting Rename. If you double-click on a folder, you can access it and
perform the same operations within that folder.

QUICK TIP Just as folders and directories are the same thing, so are folders and subfolders . . . well,
almost. When we refer to subfolders, we are referring to folders contained within another
folder. For example, /home is a folder, while we can refer to /home/mako as a subfolder of
/home.
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Figure 3-13 Accessing your home folder files is as simple as clicking Places >
Home Folder.



File Browser is also flexible in how your files are displayed. You can view
the files and folders as either the default collection of icons or as a list. To
switch to the list view, select View > View As List. You can also configure
the organization of how your files and folders are displayed by right-click-
ing the main part of the window and selecting one of the options in the
Arrange Items menu. Play with each of these options to see which ones
work best for you.

QUICK TIP Just like in the file dialog, File Browser displays each of the different parts of the path as dif-
ferent buttons. As an example, /home/mako/work would have three buttons: home, mako,
and work.

Selecting, Copying, and Moving Files and Folders
Copying and moving files and folders are simple tasks with File Browser
and can be done in a number of different ways. To test this, create two
folders called Work and Invoices in your home directory. Save some files
inside each folder. You can quickly create empty files by double-clicking
the folder to go into it, right-clicking, selecting Create Document > Empty
File, and renaming the file to something useful. With a couple of folders
now complete with files in them, let’s move them around.

One method is to use two windows. Right-click the Work folder, and select
Open in new window. You now have two windows open, one with the con-
tents of Work and one with the contents of your home directory. Now copy
the Invoices folder to the Work folder by clicking it and dragging it over to
the second window (which shows the contents of Work). By default, drag-
ging from one window to another copies the item.

Another option is to select what you want to copy and paste it. Selecting
items can again be done in a number of ways. One method is to click each
file/folder while holding down the Shift or Ctrl keys to make multiple selec-
tions. The difference between the two keys is that Shift allows you to select a
number of files and folders next to each other, and Ctrl selects independent
files and folders from anywhere in the folder-listing view. When you have
selected what should be copied, right-click and select Cut or Copy. Cut will
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copy the original files but remove them, and Copy will just copy them while
leaving the original files intact. Now go to the destination folder, right-click
it, and select Paste. The files/folders are now added.

Using the Sidebar
The sidebar in File Browser can be changed to a variety of views that
should cater to virtually all tastes. Each of these different sidebar views has
a range of functions. Table 3-1 explains each one.

Although you will probably stick with one in particular, it is not uncom-
mon to switch between options to achieve a particular task. For this rea-
son, the flexibility provided by the range of sidebar options is useful. You
can find out more about using File Browser at http://live.gnome.org/
DocumentationProject/UserGuide/Nautilus, where it is referred to using
its official GNOME name, Nautilus.

TIP Drag and Drop
If you want to put something in the Places view, drag and drop the item. The Ubuntu desktop
is filled with drag-and-drop shortcuts like this. If you think something could be dragged and
dropped, try it!
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Table 3-1 The Different File Browser Sidebar Options

Option Feature

Places (Default view) Includes the devices and bookmarks in the sidebar
that you typically see in the File Browser.

Information Displays some limited information about the current folder.

Tree Displays a tree view similar to Windows/Mac OS X. Those of you
who love the way Windows/Mac OS X works may want to use this.

History Displays a history of the folders you have clicked on.

Notes Allows you to write notes in the sidebar that are stored in the
folder. This is handy when you need to explain or make comments
about the current folder.

Emblems Lists the files and folders that have specific emblems attached.

http://live.gnome.org/DocumentationProject/UserGuide/Nautilus
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Graphically Accessing Remote Files
Within the Ubuntu desktop, you can use the same powerful file manager to
manage files that are on a remote server, either on your local network or in
far-flung parts of the world via the Internet. This feature is incredibly useful
when you need to transfer lots of files around, such as when you work on
Web pages or need to make your work remotely available to someone else.
To access these files, you can connect to the server in various ways, each of
which requires a connection profile. This profile configures the connection,
and you need to gather your server’s settings to create it.

To set up the connection, click Places > Connect to Server, and you will see
the dialog shown in Figure 3-14.

When the dialog box appears, select the type of connection from the
combo box. The box then adjusts to display the settings required, and you
should make sure the Name to Use for Connection box contains a descrip-
tive name for the connection, such as “Work Server” or “Web Site.” When
you have added the settings, click the Connect button to continue.

An icon now appears on your desktop for the connection. Double-click the
icon, and you are asked for a password to the server. Enter this password,
and you are then asked if you would like to store your passwords in the
keyring. The desktop keyring provides a convenient place to store all of
your connection passwords, and you need to remember only the password
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for the keyring itself. If you choose to store the password in the keyring, you
are asked for a password for it. In the future, whenever you double-click the
icon to access the server, you will be asked for the keyring password.

When you have been authenticated to access the server, your files appear in
a file manager window, and you can use the file manager as normal.

You can also use File Browser to access Samba and NFS shared drives, FTP
servers, remote ssh connections, and more by using the correct prefix in an
entry in the Location box, such at ssh://accountname@192.168.1.109 to
access an account on a computer at that IP address on your network via
ssh. Use smb:// for Samba, nfs:// and ftp:// for those protocols.

QUICK TIP You can learn more about the protocols File Browser can use to connect to shared storage
and how to use them at http://library.gnome.org/users/user-guide/stable/gosnautilus-515.
html.en.

Ubuntu and Multimedia
In recent years, multimedia has become an essential part of computing.
Watching DVDs and videos and listening to CDs and music have become
part and parcel of the modern desktop computer experience. These multi-
media capabilities have been further bolstered by the huge popularity of
legal music downloading. With a range of online stores for a variety of dif-
ferent types of music, it is not uncommon to listen to most of your music
without ever seeing a little shiny silver disk.

Installing Codecs
Multimedia files and disks come in a variety of different types, and each
type uses a special codec to compress the content to a smaller size while
retaining a particular level of quality. To play this media, you need to
ensure that you have the relevant codecs installed. Ubuntu now makes this
easier by suggesting packages that provide a suitable codec when you open
a file that isn’t supported by the ones that are currently installed. Simply
double-click the file you want to open, and you should be provided with a

http://library.gnome.org/users/user-guide/stable/gosnautilus-515.html.en
http://library.gnome.org/users/user-guide/stable/gosnautilus-515.html.en


list of packages that you can install to enable support for the file you have
tried to open. Select the packages that seem appropriate, and click Install.

QUICK TIP If you double-click a file but no packages are suggested, you may need to change the pack-
age filter in the top right-hand corner to All Available Applications.

Codecs still remain a problem for open source software because of the
legal restrictions placed upon them. Certain codecs (including MP3, Win-
dows Media Format, QuickTime, and RealMedia) are proprietary and as
such have restrictions placed on their use, distribution, and licensing.

Although developers in the open source community have gone away and
created free implementations of some of these codecs, the licensing that
surrounds them conflicts with the legal and philosophical position that
Ubuntu has set. These codecs are excluded not only because they are
legally dubious but also because they disagree with Ubuntu’s ethic of cre-
ating a distribution that consists entirely of free software in the most free
sense of the word.

QUICK TIP If you want to find out more about installing these codecs, see https://help.ubuntu.com/
community/RestrictedFormats.

To work toward resolving these problems, a number of developers are work-
ing on free codecs such as Ogg Vorbis and Ogg Theora that provide high-
quality results and open licensing. The Ogg Vorbis codec is used on audio
and can provide better results than MP3 at a smaller file size. The Ogg The-
ora codec is used for video and competes with the MPEG-4 codec. Ubuntu
includes the Ogg Vorbis and Ogg Theora codecs by default, and you can
encode and play back any media that uses those codecs out of the box.

Although the world would be a better place if all codecs were free, the real-
ity is different, and many Ubuntu users still want to play media com-
pressed with proprietary codecs. Table 3-2 shows the most typical codecs
used to encode and play back media and lists their support in Ubuntu.
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Listening to Audio Files
Ubuntu includes a powerful music player called Rhythmbox to organize
and play your music file collection. By default, Ubuntu will look for music
in the Music directory accessible in the Places menu.

Using Rhythmbox  Load Rhythmbox (Figure 3-15) by clicking on Appli-
cations > Sound & Video > Rhythmbox Music Player. The Rhythmbox
window is split into a number of different panes, each displaying different
details about your music collection. The left pane (Source) lets you select
the source of the music, such as your media library, podcasts, and Internet
radio. Each of these options has a browser pane available to display the
source of the content. As an example, when you use the Library, one pane
displays the artists and one displays the albums. You can use this to navi-
gate your music.

Listening to Podcasts  Podcasts are audio shows that you can subscribe
to, and they are increasingly becoming the new way to listen to audio and
music. When you subscribe to a podcast, each new release is automatically
downloaded for you. This makes it extremely convenient to regularly lis-
ten to audio shows.
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Table 3-2 Codec Support

Codec File Type Included Supported

MP3 .MP3 No Yes

Ogg .ogg Yes N/A

Flac .flac Yes N/A

Windows Media Audio .wma No Yes*

Wave .wav Yes N/A

MPEG-1 .mpg No Yes

MPEG-2 .mpg No Yes

Raw DV .dv Yes N/A

Quicktime .mov No Yes*

Windows Media Video .wmv No Yes*

* These codecs involve the installation of nonfree software that may or may not be legal in
your country.



Rhythmbox has good support for Podcast feeds, and subscribing to a feed
is simple. In the sidebar, right-click the Podcasts entry and click New Pod-
cast Feed. Paste in the feed by right-clicking the box and selecting Paste.
The files are automatically downloaded, and you can listen to them by
double-clicking on them. Each time you start Rhythmbox, a check is made
to see if any new episodes exist, and if so, they are downloaded.

NOTE Rhythmbox and iPods
Rhythmbox can also read songs from your iPod—just plug it in and it will display in Rhythmbox.
Rhythmbox can read from the iPod but may not be able to write to all iPods.

Playing and Ripping CDs
When you pop a CD into your CD drive, Audio CD Extractor (Sound
Juicer) automatically loads to play your CD. If you are connected to the
Internet, the CD is looked up on the Internet, and the album details and
song titles are displayed.
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Ripping Songs as Oggs  Sound Juicer is not just a CD player but a ripper
too. Using a ripper you can convert the songs on the CD into files that you
can play on your computer. By default, Sound Juicer rips the files in the Ogg
format, which provides better sound quality than MP3 at a smaller size. By
default, the ripped files are stored in the format discussed earlier, with each
artist as a folder and albums as subfolders.

To rip the songs, just select the checkboxes of the songs you want ripped
(by default, all songs are selected), and then click Extract. Each song is
then stored in your Music folder, and the song titles are used as the names
of the files.

Ripping Songs as FLACs  Sound Juicer is capable of supporting the
audiophile-preferred FLAC format. Just change the output format in the
program’s preferences.

Ripping Songs as MP3s  Although the default Ogg support or free FLAC
formats are recommended in most situations, you may prefer to rip MP3
files if you have a digital audio player that does not support Ogg or FLAC
files. To do this, you need to configure Sound Juicer to enable MP3 support.

You should first use Synaptic to install the gstreamer0.10-plugins-ugly-
multiverse package (see Chapter 4 for more details on installing packages).
Next, in Sound Juicer, click Edit > Preferences and choose the CD Quality,
MP3 (MP3 audio) profile from the Output Format options.

Buying Music
Canonical has added a special new option within Rhythmbox. You may
now buy music through the Ubuntu One Music Store alongside Jamendo
and Magnatune. While Jamendo and Magnatune are great sources for cre-
ative commons and other open-licensed music, for the first time, major
and minor label artists will have their music available directly from within
Ubuntu. These are the songs you would typically find in your local record
shop or on a radio station. Music in the Ubuntu One Music Store will be
encoded at a minimum of 256 kbps in MP3 format without any digital
rights management (DRM). An Ubuntu One account (mentioned earlier
in the chapter) is required to purchase music.
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NOTE You can learn more about the Ubuntu One Music Store at https://wiki.ubuntu.com/UbuntuOne/
MusicStore.

Interacting with Photos
F-Spot is a photo management program that you may use to import your
pictures, organize them, and perform basic touch-ups like removing red
eye, cropping, or simple color adjustment. When F-Spot imports photos, it
reads the metadata embedded in the image file and then sorts the images by
date. Once done, it creates a timeline that allows you to view photos easily
as a group, individually, and even as a full-screen slideshow. You can export
your photos individually or in groups directly from F-Spot to well-known
Web services like Flickr or Google’s Picasa, to a folder, or even to a CD you
could give to a friend or family member. You can find F-Spot in the menu at
Applications > Graphics > F-Spot Photo Manager. More information about
F-Spot is available at https://help.ubuntu.com/community/F-SpotHowto.

Watching Videos
To watch videos in Ubuntu, you need to ensure that you have the correct
codecs installed. As discussed earlier, some of these codecs are available
separately due to the legal implications of including them with the
Ubuntu system. Although the new process for suggesting and installing
codecs should cover most popular types of files, you should still refer to
the Ubuntu wiki at http://wiki.ubuntu.com for details of how to install
ones that are not recognized.

Using Totem  To watch videos in Ubuntu, you use the Totem media player
(Figure 3-16). Load it by clicking Applications > Sound & Video > Movie
Player.

To watch a video on your hard disk, click Movie > Open, and select the file
from the disk.

TIP Another Way to Load Files into Totem
You can also load multimedia files into Totem by double-clicking them on your desktop or in
the file manager.

https://wiki.ubuntu.com/UbuntuOne/MusicStore
https://wiki.ubuntu.com/UbuntuOne/MusicStore
https://help.ubuntu.com/community/F-SpotHowto
http://wiki.ubuntu.com


Totem also supports video streams. To watch a stream, click Movie > Open
Location, and enter the Internet address for the stream. The video feed is
then loaded and displayed.

Getting DVDs to Work  Ubuntu comes with DVD support for unen-
crypted DVDs. With the DVD industry being what it is, the majority of
DVDs come encrypted, and if you want to watch them, you need to ensure
that a library that can decrypt these DVDs is installed. Unfortunately, this
library needs to be installed separately and is not included with Ubuntu.
Refer to the Ubuntu restricted formats page at https://help.ubuntu.com/
community/RestrictedFormats for details.

With the library installed, insert a disk into your computer, and Ubuntu
will automatically start Totem to view the disk. Alternatively, fire up Totem,
and click Movie > Play Disk to play the DVD. Totem doesn’t support DVD
menus but you can still use it to play a DVD.
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Figure 3-16 Totem is a simple and flexible media player.
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If you are settling down to watch a movie, you may want to configure a few
other settings. First click View > Aspect Ratio to select the correct aspect
ratio for your screen, and then select View > Fullscreen to switch to full-
screen mode. To exit full-screen mode, just move your mouse, and some
on-screen controls will appear.

TIP Control Totem with a Remote Control
Totem supports the Linux Infrared Control (LIRC) library so you can use a remote control
while watching your media.

If you want to use a remote control with your Ubuntu computer, you need
to install the Linux Infrared Control (LIRC) package in Synaptic. LIRC is
the library, and it supports a wide range of remote control units.

The first step is to determine which LIRC driver is required for your par-
ticular remote control. Take a look at the list of remotes on the LIRC site at
www.lirc.org, or use your favorite search engine if your remote is not listed
on the site.

LIRC includes a number of built-in drivers. You can see which ones are
included by running the following command:

foo@bar:~$ lircd –driver=help

When you know which driver is required and you know your installed
LIRC supports your hardware, you can edit the hardware.conf file in the
/etc/lirc file to configure which one is used. Simply set the DRIVER line to
the driver you selected. Then restart LIRC:

foo@bar:~$ /etc/init.d/lirc restart

With LIRC ready and running, you can test it by running the following
command:

foo@bar:~$ /etc/init.d/lirc restart
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When you press the buttons on your remote control, a code should appear.
This code can be mapped to a button on your remote by editing the lircd.
conf file in /etc/lirc. For more information, see http://help.ubuntu. com/
community/  LIRC.

Creating Videos
PiTiVi is a movie editor that is based on the same media framework as
Rhythmbox and Totem, GStreamer. As a result, it handles any video for-
mat supported by GStreamer, which makes it very powerful indeed. It has
interface options ranging from the simplicity of iMovie to a more complex
professional view, as in Complex View. The goal is an easy-to-use but pow-
erful piece of software for taking your video footage from your camera and
editing it, adding effects and transitions, and mixing audio to create your
own personal cinematic masterpiece. More information about PiTiVi is
available at www.pitivi.org. PiTiVi can be found in your menu at Applica-
tions > Sound & Video > Pitivi Video Editor. 

Exploring the Ubuntu Landscape
Unlike many other operating systems, Ubuntu includes a comprehensive
suite of applications right inside the system. This range of tools has been
selected to allow you to install Ubuntu and get your work done, communi-
cate with other people, read and create documents, watch and/or listen to
media, and more. Unfortunately, due to space restrictions, this book can
only skim over the surface of available applications.

To help remedy this a bit, here is a quick summary of many of the applica-
tions listed on the Applications menu in Ubuntu, including how to find
the applications and a brief description.

� gedit Text Editor

Applications > Accessories > gedit Text Editor

This simple yet powerful text editor is ideal for editing documents,
making quick notes, and programming. Included is a range of plug-
ins for spell checking, statistics, file listings, and more.
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� Calculator

Applications > Accessories > Calculator

For those times when you need to figure out a percentage or calculate
whether you are getting a raw deal from your employer, the calculator
is there. It provides a range of functionality for simple and scientific
calculations.

� Terminal

Applications > Accessories > Terminal

Underpinning the desktop is an incredibly powerful command-line
core. This application puts a window around a command-line
interface and allows you to configure transparency, fonts, behavior,
and more. Essential for the command-line junkies among you.

� Quadrapassel (ex-Gnometris)

Applications > Games > Quadrapassel

If you have too much time on your hands, a surefire way to waste it is to
play this version of Tetris. If you decide that single-player Tetris is not
enough, you can install gtetrinet from the Ubuntu Software Center.

� Mahjongg

Applications > Games > Mahjongg

For those of you who actually understand the rules of Mahjongg, this
application provides a great implementation of the game.

� Sound Recorder

Applications > Sound & Video > Sound Recorder

If you need to record something, such as your voice for a podcast or
audio message, you can use this simple tool.

� System Monitor

System > Administration > System Monitor

To get an idea of the current performance or load on your computer,
click on this tool. The System Monitor lets you know which
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applications are running and how much memory/processing power
they are using, and it also allows you to kill or restart processes that
are hogging the resources.

� Sudoku

Applications > Games > Sudoku

The increasingly popular logic game arrives on Ubuntu.

� Disk Usage Analyzer

Applications > Accessories > Disk Usage Analyzer

Bits and bytes never looked so good! In case you were wondering
exactly where all your disk space had gone, this will help solve the
mystery.

Other Applications to Try  There are literally thousands of available pack-
ages that can be installed on your Ubuntu computer. These packages span
a range of different areas, and this section highlights some of the popular
ones. Software installation is covered in Chapter 4.

� Inkscape

Package to install: inkscape

Inkscape (Figure 3-17) is a drawing package for creating Scalable
Vector Graphics (SVG). Ever since the SVG format was introduced, it
has taken the design world by storm. SVG allows the creation of
graphics that can scale to any size. Inkscape is a hugely flexible tool
for creating such graphics, and a huge range of icons and artwork in
open source projects are made in Inkscape.

� Gimp

Package to install: gimp

The GIMP Image Editor (Figure 3-18) is a powerful raster or bitmap
graphics program that lets you draw, paint, edit images, and much
more. It is similar to proprietary graphics programs and has the ability
to process and create images using layers, plug-ins, and much more.



� Blender

Package to install: blender

Blender (Figure 3-19) is an incredibly powerful 3D modeling,
animation, rendering, and production studio. Blender amasses an
impressive range of functionality for creating photorealistic scenes,
animations, and real-time virtual walkthroughs. Blender is also fully
scriptable in Python.
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� Scribus

Package to install: scribus

Scribus (Figure 3-20) lets you lay out pages graphically and create
publication-ready output in PDF and Postscript formats. It is ideal
for newsletters, magazines, technical documentation, and more. It
supports CMYK color, Unicode text, and many graphic formats in the
creation process.

� Bluefish Editor

Package to install: bluefish

For those of you who want to create Web pages but prefer to write
code, Bluefish Editor (Figure 3-21) is a lightweight but feature-rich
editor with support for a range of languages as well as HTML and CSS.
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� Tracker Search Tool

Package to install: tracker

Have you ever tried to search your computer for a file, but couldn’t
remember the file’s name? Tracker (Figure 3-22) was created to help
in these situations by indexing the contents of your hard drive using
the metadata and tags attached to your files and allowing you to
search with greater precision and accuracy.

� Audio CD Extractor

Package to install: sound-juicer

Many of us have legally purchased compact disks that we would like
to listen to using our computer or portable music player. Audio CD
Extractor (Figure 3-23) will help you record the songs to your hard
drive so you may do so. With this package installed, it is also possible
to rip a CD from within Rhythmbox, making the process even more
convenient.
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Moving to the Next Ubuntu Release
So your system is up to date and current, but Ubuntu doesn’t like to let the
grass grow. One of the original goals for Ubuntu was to have frequent
releases, and with only one notable exception (the 6.06 LTS release, which
was delayed by two months), there have been six months between each
release since 4.10. This book has been revised for the latest version—
10.04—but another release will be along soon. Release 10.04, like the earlier
8.04 and 6.06, is a Long Term Support (LTS) version of Ubuntu, supported
for three years on the desktop and five on the server. All other versions are
supported for eighteen months and at the same time are superseded by a
new version every six months. Essentially, if you are running the LTS ver-
sion, you might not be too interested in moving to the latest and greatest
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until the next LTS version comes out, but if you are running a regular
release version, you might be the sort of person who is more interested in
the latest and greatest software updates. In either case, this is how you per-
form the upgrade.

Doing the Actual Upgrade
A graphical tool called Update Manager, found in the System > Adminis-
tration menu, tells you when a new version of Ubuntu is available and
walks you through the upgrade process. Note that if you already know or
want to learn the manual method, that is fine too. Both means will achieve
the same result.

When a new release is available, Update Manager will alert you, as in Fig-
ure 3-24. All you need to do is click on the Upgrade button to start the
process. You will first be shown the release notes, which mention new fea-
tures or any outstanding bugs. After you click on the Upgrade button on
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this screen, the necessary changes to your software repositories are made,
and then the program downloads and installs the new distribution. You may
be prompted if you have changed any configuration files. After the actual
installation is complete, you will be told which, if any, packages are no longer
officially supported by Ubuntu (have moved to the universe repository).
Last, all you need to do is restart your computer when prompted, and you
will begin enjoying the new release.

You can also initiate an upgrade simply by inserting a CD that contains a
newer version of Ubuntu than the one you are currently running, as
shown in Figure 3-25. Follow the prompts for an upgrade experience sim-
ilar to using the update manager.

Summary
In this chapter, you’ve learned how to start using the core features of your
new desktop. These concepts should allow you to perform most of the
day-to-day tasks when using your computer and provide a base from
which to explore the other applications installed on your system. This
solid grounding in the desktop paves the way for you to meander through
the rest of the book, learning about the more advanced uses of your new
system and exploring the enormous flexibility that Ubuntu provides.

Always remember that there is a wealth of help and documentation avail-
able online. If you ever find yourself stuck, take a look at the Ubuntu Web
site at www.ubuntu.com or the Ubuntu documentation at http://help.
ubuntu.com and make use of the forums, wiki, mailing lists, and IRC chan-
nels. Much of this is easily found in links provided for you in System >
About Ubuntu in your menu.
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$ (UNIX shell symbol), 160

. (dot) prefix files, 134

@ (at sign), in command-line username, 339

$ (dollar sign), UNIX shell symbol, 160, 339

# (hash), comment indicator, 158

- (hyphen), dash in commands, 341

? (question mark), wildcard character, 350

| (vertical bar), pipe symbol, 137, 341

[ ] (brackets), wildcard characters, 350

[! ] (brackets, exclamation point), wildcard

characters, 350

~ (tilde), home directory indicator, 160, 339,

344

2D launcher, 296–300

3D mapping, 289

3D modeling, 105–106

Access permissions. See Permissions; sudo

command; Superusers.

Accessibility, 21, 265

Add or Remove Software, 267

addgroup command, 348

Adding

applets to the desktop, 66–67

icons to the desktop, 66

items to Plasma, 257

partitions. See Partitioning disks.

printers, 128

programs. See Adding/removing programs.

user groups, 348

Adding users

adduser command, 348

Ubuntu, 65–66, 124–125

Ubuntu Server, 168

Adding/removing programs. See also Add or

Remove Software; Installing; Software

Center.

Kubuntu, 260–262, 267

adduser command, 125, 168

Adept. See KPackageKit; KPackageKit installer.

Administration menu item, 64

Administrator. See System administrator.

Advanced Package Tool (APT). See APT

(Advanced Package Tool).

Advanced tab, 264, 267, 269–271

Advanced User Settings, 269–271

Advocacy, user involvement, 240

Akonadi configuration, 269

Akregator, 286–287

Algebra, 205

Alternate install CD

Kubuntu, 249

Ubuntu. See Installing Ubuntu from alternate

install CD.

Amarok music manager, 276

AMD64 support, 37

Anagrams, 200

Andalusian government distribution, 316

Animation, 105–106

Annotating folders. See Emblems.



Announcements, 219

Answers, 30, 323

Applets, 66–68. See also specific applets.

Application Launcher, 254–255

Applications. See also specific applications.

closing, 63

context menu, viewing, 69

displaying in the taskbar, 69

docking. See Docky.

hiding/showing, 69

installing, 72

maximizing, 63

minimizing, 63

moving between virtual desktops, 69–70

not in repositories, installing, 121–122

open, displaying, 69

recently used, 255

running, listing, 299

starting, 62–63, 72.  See also Applications

menu; GNOME Do.

switching between, 69

Ubuntu/Windows equivalent. See Windows

programs, Ubuntu equivalents.

vendor lock-in, 77

writing and tracking, 322–323

Applications menu. See also Desktop 

(Ubuntu).

Calculator, 103

command-line interface, 103

Disk Usage Analyzer, 104

F-Spot Photo Manager, 99

Mahjongg, 103

Quadrapassel, 103

Sound Recorder, 103

starting applications, 62

Sudoku, 104

System Monitor, 103

Terminal, 103

Text Editor, 102

Applications tab, 255

Appointments. See also Calendars.

Kubuntu, 285–286

Ubuntu, 83–84

APT (Advanced Package Tool)

# (hash), comment indicator, 158

apt-cache utility, 160–163

apt-get utility, 160–163

aptitude utility, 165–166

comment lines, 158

definition, 116

Ubuntu archive, 156–157

Ubuntu Server packages, 157–163

apt-cache utility, 160–163

apt-get utility, 160–163

aptitude utility, 165–166

Architectures supported by Ubuntu, 36–37

Archive management, 319–320

ARM support, 37

Array failure, RAID, 150

Array management. See LVM (Logical Volume

Manager).

Artwork, user involvement, 241–242

Astronomy, 202–203

At sign (@), in command-line username, 339

Atlas of the world, 204–205

Audio. See also Multimedia; Music.

CDs. See CDs, audio.

FLAC format, 98

iPods, 97

MP3 format, 95, 98

Ogg Theora, 95

Ogg Vorbis, 95

playing, 96–97

podcasts, 96–97
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recording music or sound, 103, 108

restricted formats, 95

Rhythmbox, 96

settings, 67

Sound Recorder, 103

sound recording, 103

Audio CD Extractor, 97–98, 108

auth.log, 171

Automatic

login, 272

name completion, files and folders, 341

printer detection, 130–132

Avatars, Ubuntu Forums, 336

Backgrounds, desktop. See Themes and

backgrounds.

Backing up data. See also RAID (redundant

array of inexpensive disks).

incremental backups, 138

before installing RAID, 149

prior to installation, 42

strategies for, 137–140

tools for, 138

Backports repository, 157

Balneaves, Scott, 311

Basinger, Mike, 237

Bazaar, 29–30, 324–325

/bin folder, 135

Binary uploads, Ubuntu archive, 164

BIOS configuration problems, 41

BitLocker, Ubuntu equivalent, 154

Blank desktop, 61–62

Blender, 105–106

Blinken, 205

Blogs, 74, 230–231

Bluefish, 106, 107

Blueprint, 30, 322–323

Bochs, virtualization, 175

Bookmarking Web pages, Konqueror, 278

Bookmarks

creating, 84–86

file chooser, 84–86

files and folders, 84–86

live, 74

in the sidebar, 92

tagging, 74

Web sites, 74

Books and publications

Inkscape: Guide to Vector Drawing Program,

194

The Linux Documentation Project, 353

The Official Ubuntu Server Book, 173, 311,

352

A Practical Guide to Linux® Commands..., 353

/boot folder, 135

“Bootable flag” setting, 55

Bootable partitions, specifying, 55

Brackets, exclamation point ([! ]), wildcard

characters, 350

Brackets ([ ]), wildcard characters, 350

Brasero, CD/DVD burner, 127

Broadcast, chat program, 78

Browsing

files, 275

the Web. See Web browsers; specific Web

browsers.

Bug #1, 25–26

Bugs

debugging. See Technical support;

Troubleshooting.

fixing, 24

reporting and tracking, 30–31, 321–322.  See

also Launchpad; Malone.

user involvement, 242
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Bulletin boards. See The Fridge; IRC (Internet

Relay Chat); Mailing lists; Web forums;

Wikis.

Burger, Corey, 237

Burn from Disk Image option, 39

Burning CDs. See CDs, burning.

Buttons, Ubuntu desktop, 62–63, 69

Buying music, 98–99

Byobu, 350–352

Calc program, 277–278

Calculator program, 103

Calculators

Calc program, 277–278

Calculator program, 103

Kubuntu, 277–278, 288

Calendar bar, Zeitgeist, 209–211

Calendar mode, Kubuntu, 285–286

Calendars. See also Kontact; KOrganizer.

accessing from the clock, 69

appointments, 83–84

Evolution, 79, 83–84

Google, 80

Kubuntu. See Kontact; KOrganizer.

meetings, 83–84

multiple, 84

viewing, 84

Cameras. See Digital cameras.

Canonical, definition, 12

Canonical Ltd.

Bazaar, 29–30

founding of, 11–12, 27

geographical location, 27

Launchpad, 29–30

new CEO, 27

service and support, 28–29

version control tool, 29–30

as a virtual company, 11–12

working with other companies, 29

Carter, Jonathan, 311

cat command, 341, 347. See also zcat command.

Categorizing folders. See Emblems.

cd command, 341, 344

CD images. See .iso files.

CD/DVD burners

accessing, 126

Brasero, 127

GNOME, 40

ISO Recorder, 40

Nero Burning Rom, 40

CDs

alternate install. See Installing Ubuntu from

alternate install CD.

copying. See CDs, burning.

desktop. See Installing Ubuntu from desktop

CD.

installation. See Installation CDs.

CDs, audio. See also Audio.

burning, 280–281

Kubuntu, 269

playing, 97–98

ripping, 97–98

CDs, burning. See also CD/DVD burners.

accessing the burner, 126, 127

audio and data, 280–281

Burn from Disk Image option, 39

vs. copying, 41

with GNOME, 40

from images, 39–41

installation image files, 39–41

.iso files, 39, 127

from .iso files, 127

with ISO Recorder, 40

K3b program, 271
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in Linux, 40

in Mac OS X, 40

with Nero Burning ROM, 40

in Windows, 40

Cellwriter, 303

Changing directories, 341

Character recognition, 304

Chats, 78. See also IRC (Internet Relay Chat);

Mailing lists; Ubuntu Forums; Web

forums; Wikis.

Cheese, 302–303

Chief gnuisance, 317

chmod command, 345

chown command, 345

Clock

calendar access, 9, 84

description, 69

Closing applications, 63

Cloud computing, 177–178

Cloud storage, 78–79

CoC (Code of Conduct), 21–23

Code revisions, approving, 235

Codecs. See also specific codecs.

free, 95

installing, 94–95

legal restrictions, 95

Ubuntu support status, 96

for watching videos, 99

Coffee references, Ubuntu Forums, 336

Collaboration

Launchpad Ground Control, 325

Open Collaboration Services, 270–271

Color, fills and strokes, 189–190

Command line

access, Kubuntu, 288

interface. See Terminal.

package management tools, 158–159

Commands

help for. See Man pages.

syntax and usage. See specific commands.

Comment lines, in APT, 158

Commercial distributions, 317

Communicating with developers. See Ubuntu

community, communication venues.

Community Council, 235–237

Community of users. See Ubuntu community.

Compression, multimedia. See Codecs.

Computer administration

customizing your system. See Customizing.

Kubuntu. See Kubuntu customization;

Kubuntu system administration;

Software Management.

troubleshooting. See Troubleshooting system

administration.

Computer Administration section, 266

Computer menu item, 63

Computer tab, 255

Computers

names, configuring in Kubuntu, 253

older or less powerful. See Installing Ubuntu

from alternate install CD; Xubuntu.

supported by Ubuntu, 36–37

use tutorial, 205

Conferences, 229–230

Configuration files, folder for, 134–135

Configuring. See also Customizing.

BIOS, 41

keyboard layout. See Keyboards, 

configuring.

printers. See Printers, configuring.

Configuring Ubuntu desktop

background, 87

the clock, 69

screensavers, 88–89
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Configuring Ubuntu desktop, continued

themes, 87–88

wallpaper, 87

Connect to Server menu item, 64

Contacting Ubuntu developers and users. See

Ubuntu community, communication

venues.

Containerization, 175

Context menu for applications, viewing, 69

Cool Streams, 276

Copying

CDs, vs. burning, 41

folders, 91–92

Copying files

between computers, 64

cp command, 344

overview, 91–92

Copyright violations, 276. See also DRM

(Digital Rights Management).

Core philosophical ideals, 19–21

cp command, 344

Cropping images, 188–189

Cunningham, Ward, 223

Custom server kernel, 143

Customizing. See also Configuring.

the clock, 69

look and feel. See Themes and backgrounds.

menus, 122–124

screensavers, 88–89

Customizing Kubuntu. See also Kubuntu system

administration; Kubuntu system

settings.

accessibility options, 265

desktop. See Plasma.

GHNS (Get Hot New Stuff), 259–260

KMenu style, reverting to, 258

ksplash, 265

login, 271–272

monitors, making immutable, 287

splash screen, 265

Customizing Ubuntu desktop

background, 87

the clock, 69

colored background, 87

screensavers, 88–89

themes, changing, 87–88

wallpaper, 87

CVE numbers, 121

d3lphin file manager, 273

Data replication, RAID, 146

Databases, IBM DB2 support, 28

Date and time. See Clock.

DB2 database, Ubuntu support, 28

.deb file extension, 158

Debian package manager, 158–159

Debian project, 16–17

deborphan tool, 166

Debs, 158–159

Degraded mode, RAID, 150

Deleting. See also Removing.

files, 344–345

partitions, 54

user accounts, 125, 168, 348

user groups, 348

delgroup command, 348

Dell laptops, Ubuntu support, 28

deluser command, 125, 168, 348

Dependencies, 117

Derivatives of Ubuntu, 31–33

Derived distributions. See also Distributions.

for the Andalusian government, 316

commercial distributions, 317

gNewSense, 316–317

Guadalinex, 316

Linux Mint, 317
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for low-power computers, 314

Lubuntu, 317–318

Mythbuntu, 315

officially supported. See Edubuntu; Kubuntu;

Ubuntu Server Edition.

overview, 31–33

recognized. See Mythbuntu; Ubuntu Studio;

Xubuntu.

for restricted code, 317

Spanish language, 316

Ubuntu Studio, 314–315

Xubuntu, 38, 314

Desktop

KDE. See Plasma.

Kubuntu. See Plasma.

Desktop (Ubuntu). See also Applications menu;

Calendars; GNOME.

Administration menu item, 64

appearance. See Themes and backgrounds.

applets, 66–67

blank desktop, 61–62

buttons, 62–63, 69

clock, 69

Computer menu item, 63

Connect to Server menu item, 64

corner features, 70

desktop area, 61

Desktop folder, 63

Desktop menu item, 63

documentation, accessing, 64

drives, displaying, 63

help and support, 64

Help and Support menu item, 64

hiding/showing, 69

Home folder, accessing, 63

Home Folder menu item, 63

lightweight, 317–318

Linux Mint, 317

locking the screen, 71, 89

look and feel. See Themes and 

backgrounds.

Lubuntu, 317–318

LXDE (Lightweight X11 Desktop Environ-

ment), 317–318

main areas, 61

My Computer, equivalent, 63

My Documents, equivalent, 63

Network menu item, 63

Network Neighborhood, equivalent, 63

Network Places, equivalent, 63

notification area, 67–68

the panel, 61

passwords, for Administration features, 64

Preferences menu item, 64

Recent Documents menu item, 64

recently used documents, displaying, 64

Search for Files menu item, 64

servers, connecting to, 64

support, accessing, 64

taskbar, 61, 69–70

trash, 70

usability, 70

virtual desktops, 69–70

volume control, 67

Windows system tray, equivalent, 67–68

workspaces, 69–70

Desktop (Ubuntu), applications

closing, 63

context menu, viewing, 69

displaying in the taskbar, 69

hiding/showing, 69

maximizing, 63

minimizing, 63

open, displaying, 69

starting, 62–63

switching between, 69
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Desktop (Ubuntu), customizing

background, 87

the clock, 69

screensavers, 88–89

themes, 87–88

wallpaper, 87

Desktop (Ubuntu), icons

adding, 66

in the Desktop folder, 63

for devices, 62

initial view, 61

moving, 66

placing on the desktop, 63

shortcuts, 66

starting applications. See Applications 

menu.

Desktop (Ubuntu), menus

Applications, 62–63

Places, 63–64

System, 64

Desktop CD, installing from

Kubuntu, 250–253

Ubuntu. See Installing Ubuntu from 

desktop CD.

Desktop folder, 63

Desktop globe, 204–205

Desktop keyring, 93–94, 126

Desktop machines vs. servers, 24–25. See also

Ubuntu Server.

Desktop menu item, 63

Desktop publishing, Ubuntu/Windows

equivalent. See Scribus; Word

processing.

Desktop Search configuration, Kubuntu,

269–270

/dev folder, 135

Developer blogs, 74

Developer contacts

developer summits, 227–229

The Fridge, 225–227

IRC (Internet Relay Chat), 219

mailing lists, 218

Planet Ubuntu, 230–231

sprints, 227–229

user conferences, 229–230

Web forums, 222

wikis, 223–225

Developer sprints, 227–229

Developer summits, 227–229

Development discussions. See Blogs; IRC

(Internet Relay Chat); Mailing lists; 

Web forums; Wikis.

Development environment. See IDE

(Integrated Development 

Environment).

Device drivers, printers, 128, 130

Device folder, 135

Device information, displaying, 92

Device names, indicating connection type, 47

Devices. See specific devices.

df command, 345

Digital cameras, 127, 269

Digital flash cards, 205

Digital photography. See Photographs.

Digital Rights Management (DRM), 98, 276

Directories. See also Folders; Terminal

commands, files and folders.

changing, 341

definition, 133

vs. folders, 90, 133

Disabled users. See Accessibility.

Disk images. See .iso files.

Disk replication, Ubuntu Server, 177

Disk space usage, displaying, 345
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Disk storage. See also CDs; LVM (Logical

Volume Manager); USB storage devices.

across physical boundaries. See RAID

(redundant array of inexpensive

disks).

floppy disks, 127

organizing. See Partitioning disks.

USB keyring devices, 93–94, 126

Disk storage, hard disks

partitioning. See Partitioning disks.

usage analysis, 104

Disk Usage Analyzer, 104

Display section, 266

Display settings, Kubuntu, 266

Displays. See Monitors; Screens.

Dispute arbitration, 235–236

Distributed Replicated Block Device (DRBD),

177

Distribution management software, 30

Distribution upgrades, Ubuntu Server, 163–165

Distributions. See also Derived distributions;

Repositories; specific distributions.

bug fixes, 15

contents, 13

definition, 12–13

derived. See Derived distributions.

diversity of, 14–16

educational purposes. See Edubuntu.

with KDE. See Kubuntu.

for older computers. See Xubuntu.

parents of, 15

tracking changes, 15–16

Distros. See Distributions.

Distrowatch database, 14

dmesg log, 171

Docklets, 213

Docky, 211–214

Documentation. See also Help; Man pages;

Online resources; Ubuntu community,

communication venues.

GNOME desktop, accessing, 64

LVM (Logical Volume Manager), 156

RAID (redundant array of inexpensive disks),

156

user involvement, 241

Documents, creating

desktop publishing. See Scribus.

mathematical expression builder. See Math.

presentations. See Impress.

spreadsheets. See Calc.

word processing. See Word processing.

Documents, recently used, 64, 255

Dollar sign ($), UNIX shell symbol, 160, 339

Dolphin file manager, 273–274

Donating to the Ubuntu project, 31

do-release-upgrade tool, 163

Dot (.) prefix files, 134

DPI error, Scribus graphic images, 197

dpkg utility, 158–159

Draw program, 277

Drawing a rectangle, 189–193

Drawing programs. See also GIMP; Images

(graphic), editing; Inkscape.

3D modeling, 105–106

Draw, 277

SVG (Scalable Vector Graphics) format, 104,

192–193

Tux Paint, 205

DRBD (Distributed Replicated Block Device),

177

Drivers. See Device drivers.

Drives, displaying on the desktop, 63

DRM (Digital Rights Management), 98, 276. See

also Copyright violations.
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Dual boot, partitioning the disk for, 44–48

DVDs

burning. See CD/DVD burners.

encryption, video, 100

East, Matthew, 237

Ebook formats supported, 303

Ebook reader, 303–304

ecryptfs, 154–155

Editing

graphic images, 104, 105, 128, 194

network connections, 68

photographs. See Editing, graphic images.

pictures. See Editing, graphic images.

Editing text

cat command, 347

with nano editor, 347

in Scribus, 194

with sed (Stream EDitor), 347

Editions of Ubuntu. See Derived distributions;

specific editions.

Edubuntu

description, 311–313

downloading, 38

installing. See Installing Edubuntu.

LTSP (Linux Terminal Server Project), 311

online resources, 313

vs. Ubuntu, 32

Web forums, 221–222.  See also Ubuntu

Forums.

Educational applications. See also Games.

activities, enabling/disabling, 199

administration tool, 199

algebra, 205

anagrams, 200

astronomy, 202–203

Blinken, 205

computer use, 205

desktop globe, 204–205

digital flash cards, 205

drawing, 205

factorization, 201

fractions, 200–201

GCompris, 205

GCompris Administration, 199

geography, 204–205

geometrical constructions, 201

graphing mathematical functions, 201–202

hangman game, 201

Kalzium, 199–200

Kanagram, 200

KBruch, 200–201

KHangman, 201

Kig, 201

KmPlot, 201–202

KStars, 202–203

KTouch, 203

KTurtle, 204

Logo programming language, 204

maps, 204–205

Marble, 204–205

math programs, 200–201, 205

Parley, 205

periodic table, 199–200

physics simulator, 205

reading, 205

science, 205

Simon Says game, 205

space exploration, 202–203

spelling, 201

Step, 205

touch-typing tutorial, 203

Tux Paint, 205

user profiles, 199
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What’s Up Tonight?, 203

world atlas, 204–205

Education-oriented Ubuntu. See Edubuntu.

Effect filters, 186–187

Electrical power, conserving

automatically turning off monitors, 266

hibernating, 155

Kubuntu, 266

monitors, 266

suspend mode, 155

E-mail

accounts, setting up, 79–83

creating new messages, 83

Evolution, 79–83

Hotmail, 80

Kubuntu, 284–285

replying to messages, 83

sending/receiving options, 82

server setup, 81

unable to connect to server, 83

Webmail, 80

Yahoo! Mail, 80

Emblems, 92

Emblems option, 92

Empathy, chat program, 78

Encryption

disk partitions, 53

DVD, 100

swap partitions, 155

Ubuntu Server, 154–155

Ending a session. See Logging out.

Erickson, Jordan, 311

/etc folder, 135

Etrich, Matthias, 246–247

Evolution

calendar function, 79

calendars, 79, 83–84

e-mail, 79–83

Hotmail, 80

PIM (personal information manager), 79

Webmail, 80

Yahoo! Mail, 80

Excel, Ubuntu/Windows equivalent, 278

ext4 filesystem, 47–48

Extensions, Firefox, 74–75

Factorization, 201

FAT32 filesystem, 48

Fault tolerance. See RAID (redundant array of

inexpensive disks).

Favorites list

Kubuntu, 254–255

Netbook Edition, 296–299

Favorites tab, 254

Fbreader, 303–304

Feature goals, maintaining, 237

Feature tracking, 30

File associations, Kubuntu, 269

File Browser. See also File Manager.

emblems, 92

parts of, 89

sidebar, 92

starting, 89

view, switching, 91

File Browser, files

copying, 91–92

displaying, 91

moving, 91

selecting, 91–92

File Browser, folders

annotating. See Emblems.

categorizing. See Emblems.

copying, 91–92

vs. directories, 90
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File Browser, folders, continued

moving, 91

selecting, 91–92

File chooser, 84–86

File formats, Writer, 77

File management

by location. See File Browser; File Manager;

Kubuntu file management.

by tags and date modified. See Zeitgeist.

File Manager, 134. See also File Browser.

Files. See also Folders.

. (dot) prefix, 134

bookmarking, 84–86

command-line interface to. See Terminal

commands, files and folders.

contents, viewing, 341

copying between computers, 64

deleting, 344–345

display type, changing, 91

displaying, 91

emblems, 92

execution, prohibiting, 169

finding, 64, 274–275.  See also File Browser;

File Manager; Searching for files.

hidden, 134

indexing, 270

kioslaves, 274–275

Kubuntu. See Kubuntu file management.

last access time, recording, 170

last-access log, disabling, 170

listing, 63–64, 340, 345

moving, 91, 126, 344

owners, finding, 166

ownership, changing, 345

permissions, changing, 345

providers, finding, 166

remote access, 93–94

searching for. See Searching for files.

selecting, 91–92

structure changes, 273–274

thumbnail views, 209

typing names, automatic completion, 341

Files, copying

between computers, 64

cp command, 344

overview, 91–92

from USB keyrings to the hard disk, 126

Files, finding

bookmarks, 84–86

contents, 159, 347

file chooser, 84–86

grep command, 159, 347

Konqueror, 274–275

Filesystems

default, 47–48

ext4, 47–48

FAT32, 48

optimizing, 55

sharing with Windows, 48

specifying, 55

super-user space, reserving, 55

Ubuntu Server, security, 169–170

Windows vs. Linux, 133–134

FileVault, Ubuntu equivalent, 154

Fill color, 189–190

Financial support for Ubuntu. See Canonical

Ltd.; Ubuntu Foundation.

Finding. See also Search tools; Searching.

file owners, 166

file providers, 166

files and folders, 64, 274–275.  See also File

Browser; File Manager; Searching for

files.

KPackageKit, 260
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packages, 119–122

recently-used documents, 64

Synaptic, 117

Terminal, 103

Firefox

bookmarking sites, 74

description, 72–73

extensions, 74–75

Flash is missing, 75

Google searches, 74

interface, 73

Kubuntu, 279–280

live bookmarks, 74

navigating the Internet, 73

plug-ins, 74–75

search engines, adding, 74

searching, 74

security, downloading extensions, 75

starting, 73

tagging bookmarks, 74

Web site, 72

Firewall tables, 172–173

Firewalls, 172–173

FLAC audio format, 98

Flash, missing from Firefox, 75

Flash cards, digital, 205

Flash disks. See USB storage devices, keyring

devices.

Floppy disks, mounting/unmounting, 127

Folders. See also Files.

. (dot) prefix, 134

accessing, 255

annotating. See Emblems.

/bin, 135

/boot, 135

categorizing. See Emblems.

changing, 344

command-line interface to. See Terminal

commands, files and folders.

configuration files, 134–135

copying, 91–92

creating, 90, 345

current, identifying, 343

current, printing, 343

current information, displaying, 92

definition, 133

/dev, 135

vs. directories, 90, 133

display type, changing, 91

emblems, 92

/etc, 135

files in, listing, 340, 345

finding, 64, 274–275.  See also File Browser;

File Manager.

hidden, 134

history, displaying, 92

/home, 135

indexing, 270

/lib, 135

/media, 135

/mnt, 135

moving, 91

naming, 90

/opt, 135

ownership, changing, 345

permissions, changing, 345

/proc/sys, 135

/root, 135

/sbin, 135

selecting, 91–92

subfolders, 90

tree view, displaying, 92

typing names, automatic completion, 341

/usr, 135
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Folders, continued

/var, 135

working, printing, 343

Fonts

choosing, 76, 185

Kubuntu, 266

“Format the partition” setting, 55

Forums. See Web forums.

Forums Code of Conduct, 337

Fractions, 200–201

free command, 345

Free software

access to source code, 5

characteristics of, 4

Debian project, 16–17

freedoms, 4

history of Ubuntu, 16–17

meaning of “free,” 4, 6

vs. open source, 6–7

philosophical goals, 19–21

FREE SPACE line, 54

Freedesktop.org standards, 273

Freedoms of free software, 4

FreeNode IRC network, 220–221

The Fridge, 74, 225–227

F-Spot Photo Manager, 99, 128

fstab file, 136–137

Full virtualization, 175

Games. See also Educational applications.

Blinken, 205

hangman, 201

KHangman, 201

Mahjongg, 103

Quadrapassel, 103

Simon Says, 205

Sudoku, 104

GCompris, 205

GCompris Administration, 199

General chat. See Mailing lists; Wikis.

Geographical location, specifying

from alternate install CD, 51

from desktop CD, 42–43

Geography, 204–205

Geometrical constructions, 201

Georgopoulos, Alkis, 311

GFS (Global File System), 144

GHNS (Get Hot New Stuff), 259–260

GIMP (GNU Image Manipulation Program).

See also Images (graphic); Inkscape.

creating an image, 184

cropping, 188–189

effect filters, 186–187

font selection, 185

help, 189

layers, 186–188

moving text, 185

package description, 182

starting, 183

templates, 182, 184

text boxes, 185

toilet paper template, 182, 184

tool palette, 185

user interface, 183–184

GIMP Image Editor, 104, 105, 128

Globe application, 289

gNewSense, 316–317

GNOME

activity journal, 208–209

burning CDs/DVDs, 40

help for, 64

GNOME desktop. See Desktop (Ubuntu).

GNOME Do, 211–212

GNOME-shell

cycling through open windows, 208

description, 206
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displaying recently run applications, 207

vs. GNOME desktop, 206–207

grouping windows, 208

keyboard shortcuts, 208

listing common applications, 207

online resources, 208–209

overlay mode, 207

searching for applications, 207

trying it out, 206

workspaces, adding/removing, 208

Gnometris, 103

GNU General Public License, 247

GNU Image Manipulation Program (GIMP).

See GIMP (GNU Image Manipulation

Program).

GNU project, history of Ubuntu, 3–7

Goals of Ubuntu

accessibility to disabled users, 21

Bug #1, 25–26

CoC (Code of Conduct), 21–23

code modifications, 21

desktop/server support, 24–25

governance system, 232

LCoC (Leadership Code of Conduct), 23

localization (native language), 20

philosophical, 19–21

programming simplicity, 25

technical, 23–25

Gobuntu. See GNewSense.

Google calendars, 80

Google searches

desktop search box, 74

Firefox, 74

Konqueror, 275, 279

Kubuntu, 275, 279

Governance. See Ubuntu community,

governance system.

Graber, Stéphane, 311

Gradients, 190–191

Graphics. See Drawing programs; GIMP;

Images (graphic), editing; Inkscape.

Graphing mathematical functions, 201–202

Green dragon, 247

grep command, 159, 347. See also zgrep command.

Group memberships, 125

Group permissions, 169

Groups, user accounts. See User groups.

Gtranslate. See Rosetta.

Guadalinex, 316

Guest Session option, 71

Guided—Use Entire Disk... options, 52–53

Gwenview, 289

Gwibber, chat program, 78

HAL devices, listing, 346

Handicapped users. See Accessibility.

Handwriting recognition, 304

Hangman game, 201

Hard disks. See Disk space; Disk storage; LVM

(Logical Volume Manager); Partitioning

disks.

Hardware. See also specific devices.

detection, from alternate install CD, 51

listing, 346

virtualization emulation, 175

Harmony project, 247

Hash (#), comment indicator, 158

HBD (Here Be Dragons), 8

Hearing-disabled users. See Accessibility.

Help. See also Man pages; Online resources;

Technical support; Troubleshooting.

About GNOME, 64

About Ubuntu, 64

Canonical Ltd., service and support, 28–29

for commands. See man pages.

GIMP, 189
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Help, continued

Help and Support menu item, 64

-help command, 348

Inkscape, 193

Kubuntu, 290

Scribus, 199

Terminal commands, 343, 348–349

Ubuntu Forums, 332

Ubuntu Help Center, 64

-help command, 348

Helpers (scripts), 213–214

Hibernating, 155

Hidden files and folders, 134

Hide/Show Desktop button, 69

Hiding/showing applications, 69

Hill, Benjamin Mako, 237, 352

History of Ubuntu. See also Shuttleworth, Mark.

Debian project, 16–17

first LTS release, 3

first release, 2

GNU project, 3–7

Linux, 5

LTS (Long Term Support), 3, 24–25

open source, 6–7

Open Source Initiative, 6

Perens, Bruce, 6

Raymond, Eric S., 6

Stallman, Richard M., 3–6

Torvalds, Linus, 5

user community, 17–18

Warty Warthog, 2

History of Ubuntu, free software

and the Debian project, 16–17

and GNU, 3–7

meaning of “free,” 4

vs. open source, 6–7

History of Ubuntu Forums, 328–329

History option, 92

Holbach, Daniel, 237

Home directory

encryption, 155

folder for, 135

lockout, 155

/home folder, 135

Home folder, accessing, 63

Home Folder menu item, 63

/home partition, installing Ubuntu Server,

145–146

Home theater software, 315

Hostname, specifying

from alternate install CD, 52

from desktop CD, 49

Hotmail, Evolution support for, 80

HTML editor, 106, 107

Hypervisor, 175–176

Hyphen (-), dash in commands, 341

i386 support, 37

IBM, virtualization, 175

IBM DB2 database, Ubuntu support, 28

Icons

adding, 66

desktop, initial view, 61

in the Desktop folder, 63

for devices, 62

moving, 66

placing on the desktop, 63

shortcuts, 66

IDE (Integrated Development Environment),

289

Ideas and feedback, user involvement, 241

ifconfig command, 346

Image frames, Scribus, 196–197

Images (graphic)

editing, 104, 105, 128, 194

raster graphics. See GIMP.
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vector graphics. See Inkscape.

viewing, 289

Images (of installation CDs). See .iso files.

Immutable desktop, Kubuntu, 287

Impress, 277–278

Incremental backups, 138

Indicator applet, 68

Information option, 92

Inkscape. See also GIMP; Images (graphic).

drawing a rectangle, 189–193

fill color, 189–190

gradients, 190–191

help, 193

Inkscape: Guide to Vector Drawing Program, 194

online resources, 193–194

package description, 104, 189

PDF format, 193

PNG format, 193

saving, available formats, 192–193

starting, 189

stroke color, 189–190

SVG (Scalable Vector Graphics) format,

192–193

text, 192

tools, 189

user interface, 105

Inkscape: Guide to Vector Drawing Program, 194

Input actions, Kubuntu, 266

Installation CDs

alternate install, 36.  See also Installing

Ubuntu from alternate install CD.

burning, 39–41

desktop, 36.  See also Installing Ubuntu from

desktop CD.

downloading, 38–39

.iso files, 39

from Linux, 40

from Mac OS X, 40

mail order, 39

from Windows, 40

Installation image files. See .iso files.

Installing. See also Software Center.

codecs, 94–95

Netbook Edition, 294–296

non-Synaptic applications, 122

themes, 88

Xubuntu, 38

Zeitgeist, 209

Installing applications. See also APT (Advanced

Package Tool).

application sources. See Repositories.

not in repositories, 121–122

Installing Edubuntu

add-on CD, downloading, 38

online resources, 38

prerequisites, 38

Installing Kubuntu

from the alternate install CD, 249

computer name, configuring, 253

from the desktop CD, 250–253

downloading the image file, 249

keyboard layout, selecting, 252

online resources, 37

partitioning disks, 252

switching from Ubuntu, 249–250

time zone, selecting, 251

Ubiquity installer program, 250–253

username, configuring, 253

Installing packages

apt-get utility, 160–163

Kubuntu, 260–262

manually, 159–160

from Ubuntu archive, 156–157

Installing Ubuntu. See also Upgrading Ubuntu.

AMD64 support, 37

architectures supported, 36–37
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Installing Ubuntu, continued

ARM support, 37

backing up data, 42

CDs for. See Installation CDs.

choosing a version, 36–37

i386 support, 37

on a netbook, 294–296.  See also Netbook

Edition.

PowerPC support, 37

switching from Kubuntu, 249–250

from a USB key, 56–57

from Windows, 57

Installing Ubuntu from alternate install CD

geographical location, specifying, 51

hardware detection, 51

hostname, specifying, 52

installing a server, 51

keyboard configuration, 51

language selection, 50

time zone, setting, 52

user account configuration, 55–56

Installing Ubuntu from alternate install CD,

partitioning the disk

adding partitions, 54–55

“Bootable flag” setting, 55

bootable partitions, specifying, 55

deleting partitions, 54

filesystem, specifying, 55

“Format the partition” setting, 55

FREE SPACE line, 54

Guided—Use Entire Disk... options, 52–53

“Label” setting, 55

labeling partitions, 55

Manual option, 53

mount options, 55

“Mount point” setting, 55

mount points, 55

“Reserved blocks” setting, 55

root partition, creating, 54

settings, 55

“Typical usage” setting, 55

“Use as” setting, 55

Installing Ubuntu from desktop CD

alongside Windows. See Dual boot.

BIOS configuration problems, 41

geographical location specification, 42–43

getting the CD. See Installation CDs.

hostname, specifying, 49

keyboard configuration, 43–44

language selection, 42

migrating from previous version, 50

password guidelines, 49

system use during installation, 50

user account configuration, 48–49

Installing Ubuntu from desktop CD,

partitioning the disk

adding a partition, 47

default filesystem, 47–48

definition, 44

for dual boot, 44–48

manually, 46–48

minimum number of partitions, 45

mount points, 48

sharing with Windows, 135–136.  See also

Dual boot.

for Ubuntu only, 45, 46

Installing Ubuntu Server. See also LVM (Logical

Volume Manager); RAID (redundant

array of inexpensive disks).

connecting to another server, 145

/home partition, 145–146

log file, 145

partitioning, 145–146.  See also RAID.

vs. regular Ubuntu machine, 143

root account, enabling, 156

ssh client, 145
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switching consoles, 145

/tmp partition, 145–146

/var partition, 145–146

Installing Ubuntu updates

applications not in repositories, 121–122

checking for updates, 120

CVE number, 121

finding packages, 121–122

limitations, 120

notification of, 120

release notifications, 120

reviewing updates, 121, 121

security vulnerability identifier, 121

security-related, 120, 121

Instant messaging, 281–282

Integrated Development Environment (IDE), 289

Internet dial-up tool, 288

iPods, 97

iptables command, 172–173

ipvsadm utility, 144

ipvsadm utility support, 144

IRC (Internet Relay Chat). See also Chats.

about Kubuntu, 283

description, 219–221

FreeNode IRC network, 220–221

list of channels, 221

private messaging, 220

Isle of Man, 27

.iso files

burning CDs from, 39, 127

definition, 39

downloading, Kubuntu, 249

ISO Recorder, burning CDs/DVDs, 40

iwconfig command, 346

Jamendo music store, 98

jdong (Ubuntu Forums denizen), 335

Johnson, Richard, 237, 311

K Control Center. See Software Management,

System Settings.

K3b program, 271

Kalzium, 199–200

Kanagram, 200

Kate, 288

Kbabel. See Rosetta.

KBruch, 200–201

KDE (K Desktop Environment)

current version, 247

desktop. See Plasma.

GNU General Public License, 247

green dragon, 247

Harmony project, 247

history of, 246–247

Konqi, 247

locking, 287

making immutable, 287

online resources, 247

QPL (Q Public License), 247

QT toolkit, 247

kde-look.org, 257

Kdesktop. See Plasma.

KDevelop, 289

keepalived utility, 144

Kernel

checking, 346

custom server, 143

Keyboard shortcuts, GNOME-shell, 208

Keyboards, configuring

from alternate install CD, 43–44

from desktop CD, 43–44

Kubuntu, 252, 266

Keyring devices, 93–94, 126

KHangman, 201

Kig, 201

Kiosk mode, 287

Kioslaves, 274–275

Index 373



KiwiNZ (Ubuntu Forums denizen), 335

Kmail, 284–285

KMenu style, reverting to, 258

KmPlot, 201–202

Konqi, 247

Konqueror

bookmarking Web pages, 279

file manager, 273–275

Google searches, 275, 279

kioslaves, 274–275

Kubuntu, 279

orange icon, 279

RSS feed indicator, 279

shortcuts, 274–275

Web browser, 278–279

Konsole, 288

Kontact. See also Calendars.

calendar mode, 285–286

e-mail accounts, setting up, 284–285

overview, 283–284

PIM (personal information manager), 

283

RSS feeds, tracking, 286–287

starting, 284

Kopete, 281–282

KOrganizer, 285–286. See also Calendars.

KPackageKit installer, 260

KPDF, 289

KPPP, 288

KRandRtray, 289

KRDC, 288

Krumbach, Elizabeth, 237

KRunner, 264

KSnapShot, 289

ksplash, 265

KStars, 202–203

KSysGuard, 288

KSystemLog, 288

KTouch, 203

KTurtle, 204

Kubuntu

accessibility, 265

description, 310–311

desktop. See Plasma.

help, 290

history of, 248–249

installing. See Installing Kubuntu.

K Control Center. See Software Management,

System Settings.

Kdesktop. See Plasma.

KMenu style, reverting to, 258

locking the screen, 255

logging in, 271

logging out, 255–256

managing repositories, 262–263

online resources, 311

overview, 246

Project Timelord, 248

restarting, 255

restarting your computer, 255

shutting down your computer, 255

Start menu. See KMenu.

vs. Ubuntu, 31–32, 38

Kubuntu applications

3D mapping, 289

Akregator, 286–287

appointment scheduling, 285–286

automatic login, 272

Calc, 277–278

calculator, 277–278, 288

calendars, 285–286

command line access, 288

Draw, 277

drawing programs. See Draw program.
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e-mail, 284–285

Excel equivalent, 278

Favorites list, 254–255

globe application, 289

Gwenview, 289

IDE (Integrated Development Environment),

289

image viewer, 289

Impress, 277–278

instant messaging, 281–282

Internet dial-up tool, 288

IRC (Internet Relay Chat), 283

K3b program, 271

Kate, 288

KDevelop, 289

Kiosk mode, 287

Kmail, 284–285

Konqueror, 278–279

Konsole, 288

Kopete, 281–282

KOrganizer, 285–286

KPDF, 289

KPPP, 288

KRandRtray, 289

KRDC, 288

KSnapShot, 289

KSysGuard, 288

KSystemLog, 288

Marble, 289

Math, 277

meetings, scheduling, 285–286

naming, 254

Numlock activation, 290

Okular, 289

OpenOffice.org, 277–278

PDF viewer, 289

Performance Monitor, 288

PIM (personal information manager). See

Kontact.

PowerPoint equivalent, 278

presentations. See Impress.

Quassel, 283

remote desktop connection, 288–289

remote dial-up tool, 288–289

RSS feeds, tracking, 286–287

running at startup, 289–290

screen capture program, 289

Speedcrunch, 288

spreadsheets. See Calc.

starting, 254–255

System Logs Viewer, 288

text editor, 288

Web feeds. See RSS feeds.

Word equivalent, 278

Word Processor, 278

Writer, 278

Kubuntu applications, Kontact

calendar mode, 285–286

e-mail accounts, setting up, 284–285

overview, 283–284

RSS feeds, tracking, 286–287

starting, 284

Kubuntu applications, Web browsing

Firefox, 279–280

Konqueror, 278–279

Kubuntu customization. See also Kubuntu

system administration; Kubuntu system

settings.

accessibility options, 265

desktop. See Plasma.

GHNS (Get Hot New Stuff), 259–260

KMenu style, reverting to, 258

ksplash, 265

locking the screen, 255
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Kubuntu customization, continued

monitors, making immutable, 287

splash screen, 265

Kubuntu file management

browsing files, 275

default manager. See Dolphin.

Dolphin file manager, 273–274.  See also

Konqueror.

file structure changes, 273–274

finding files, 274–275

folder access, 255

freedesktop.org standards, 273

Google searches, 275

kioslaves, 274–275

Konqueror file manager, 273–275.  See also

Dolphin.

music management, 276–277

shortcuts, 274–275

split view, 273

USB drive access, 276

Web searches, 275

Windows partition access, 275–276

XDG Base Directory Specification, 273

XDG directories, 273–274

#kubuntu IRC channel, 221, 283, 290

Kubuntu navigation

Application Launcher, 254–255

logging out, 255–256

Kubuntu system administration. See also

Kubuntu customization; Kubuntu

system settings; Software 

Management.

access rights, changing, 272

Adept. See KPackageKit installer.

installing packages, 260–262

KPackageKit, 260

sudo, as a root account, 257

users, creating, 272

Kubuntu system settings. See also Kubuntu

customization; Kubuntu system

administration; Software Management,

System Settings.

accessibility options, 265

adding/removing software, 267

administrative password, 257

Akonadi configuration, 269

audio CDs, 269

date and time, 266

Desktop Search configuration, 269–270

digital cameras, 269

display, 266

file associations, 269

fonts, 266

input actions, 266

keyboard behavior, 266

ksplash, 265

mouse behavior, 266

multimedia, 266

Nepomuk configuration, 269

personal information management, 269

power conservation, 266

printer configuration, 267

starting/stopping services, 269

startup services, configuring, 269

Kubuntu system settings, monitors

configuring, 289

detecting, 289

making immutable, 287

power conservation, 266

resizing, 289

rotating, 289

screen orientation, 266

screen resolution, 266

splash screen, 265

standby mode, 266

systemwide changes, 287

376 Index



turning off automatically, 266

wallpaper, 287

KVM virtualization, 175

l10n teams, 320–321

“Label” setting, 55

Labeling partitions, 55

Language selection. See also Translation and

localization.

from alternate install CD, 50

changing, 86

from the desktop CD, 42

during installation, 42, 50

Launcher, Netbook Edition, 296–300

Launchpad

Answers, 30, 323

applications, writing and tracking, 

322–323

archive management, 319–320

Bazaar, 324–325

Blueprint, 30, 322–323

bugs, reporting and tracking, 30–31,

321–322.  See also Malone.

code restrictions, 319

components, 29–30

definition, 29

description, 29–30, 318–319

distribution management, 30

feature tracking, 30

Malone, 29–30, 321–322

online resources, 320

revision control system, 324–325

Rosetta, 29, 320–321

source for installation CDs, 39

Soyuz, 30, 319–320

specification tracking, 30

support tracking, 30

translation software, 29

Launchpad Ground Control, 325

Layers, images, 186–188

LCoC (Leadership Code of Conduct), 23

Legal restrictions, downloading music, 276

less command, 347. See also zless command.

/lib folder, 135

Libraries

definition, 117

folder for, 135

Lightweight X11 Desktop Environment

(LXDE), 317–318

Linux

creating Ubuntu installation CDs, 40

filesystem, vs. Windows, 133–134

history of Ubuntu, 5

Spanish version, 316

The Linux Documentation Project, 353

Linux Mint, 317

Linux Terminal Server Project (LTSP), 311

Linux User Groups (LUGs). See LoCos (local

community teams).

Linux Virtual Server utility, 144

LinuxCommand.org, 353

Linux-VServer projects, virtualization, 176

LIRC (Linux Infrared Control), for Totem, 101

Listing

files, 63–64, 340, 345

HAL devices, 346

hardware, 346

owned files, 166

packages, 159

USB buses, 346

.lit files, converting, 303

Live bookmarks, 74

Localization. See Translation and localization.

Location. See Geographical location.

Lock Screen option, 71

Locking screens, 71, 89, 255
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LoCos (local community teams), 233–234

Log files

auth.log, 171

benefits of, 171

dmesg, 171

installing Ubuntu Server, 145

location, 171

logs of note, 171

mail.log, 171

messages, 171

printing last ten lines, 172

syslog, 171

tail utility, 172

tools for, 172

zcat command, 172

zgrep command, 172

zless command, 172

Log Out option, 71

Logging in, 271

Logging out

ending current session, 70–71

Guest Session option, 71

Kubuntu, 255–256

Lock Screen option, 71

locking the screen, 70–71

Log Out option, 71

Restart option, 71

restarting the computer, 71

Shut Down option, 71

shutting down, 71

Sleep option, 71

Switch from... option, 71

switching users, 71

Ubuntu, 70–71

Logical Volume Manager (LVM). See LVM

(Logical Volume Manager).

Logical volumes (LVs), 151–152

Login Manager, 271–272

Logo programming language, 204

Look & feel, customizing. See Themes and

backgrounds.

Look & Feel section, 265. See also Themes and

backgrounds.

Lower-power computers, running Ubuntu. See

Installing Ubuntu from alternate install

CD; Xubuntu.

ls command, 340, 345

lsb_release -a command, 346

lshal command, 346

lshw command, 346

lspci command, 346

lsusb command, 346

LTS (Long Term Support), 3, 24–25, 157

LTSP (Linux Terminal Server Project), 311

Lubuntu, 317–318

LUGs (Linux User Groups). See LoCos (local

community teams).

LVM (Logical Volume Manager). See also

RAID (redundant array of inexpensive

disks).

documentation, 156

fault tolerance, 154

LVs (logical volumes), 151–152

partition management, 150–152

PEs (physical extents), 151–152

PVs (physical volumes), 151–152

redundancy, 154

setting up, 152–154

storage fluidity, 154

theory of, 151–152

VGs (volume groups), 151–152

LVs (logical volumes), 151–152

LXDE (Lightweight X11 Desktop Environ-

ment), 317–318
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Mac OS X, creating Ubuntu installation CDs,

40

Macromedia Flash. See Flash.

Magnatune music store, 98, 276

Mahjongg, 103

Mailing lists

description, 218–221

online resources, 218

Ubuntu community, 218–221

ubuntu-announce, 219

ubuntu-devel, 219

ubuntu-devel-announce, 219

ubuntu-devel-discuss, 219

mail.log, 171

Mailman software, 218

Main areas, 61

Main repository, 157, 263

Malicious packages, 160

Malone, 29–30, 321–322

man command, 343, 348–349

man files, searching for, 349

man intro command, 349

man -k command, 349

man man command, 349

man pages. See also Help.

accessing, 343

Terminal commands, 343, 348–349

Managing repositories, Kubuntu, 262–263

Manual option, 53

Manually partitioning disks

with an alternate install CD, 53–55

with a desktop CD, 46–48

Maps

3D mapping, 289

desktop globe, 204–205

globe applications, 289

Marble, 204–205

Marble program, 289

world atlas, 204–205

Marble, 204–205

Marble program, 289

Masters of the Universe (MOTUs), 234–235

Math program, 277

Math programs, 200–201, 205

Mathematical functions, graphing, 201–202

matthew (Ubuntu Forums denizen), 335

Mauelshagen, Heinz, 151

Maximized windows, Netbook Edition,

300–301

Maximizing, applications, 60

McNealy, Scott, 178–179

Media devices, folder for, 135

/media folder, 135

Meetings, 83–84, 285–286. See also Calendars.

Memory usage, displaying, 345

Menus

Applications, 62–63

customizing, 122–124

Places, 63–64

System, 64

Meritocracy, 231

messages log, 171

Messaging, 220

Microsoft

as Bug #1, 25–26

Word documents. See Word.

Migrating from previous version, 50. See also

Installing Ubuntu updates.

Minimizing applications, 60

MIT, virtualization, 176

mkdir command, 345

/mnt folder, 135

Monitors. See also Screens.

corner features, 70
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Monitors, Kubuntu

configuring, 289

detecting, 289

locking the screen, 255

making immutable, 287

power conservation, 266

resizing, 289

resolution, 266

rotating, 289

screen orientation, 266

splash screen, 265

standby mode, 266

systemwide changes, 287

turning off automatically, 266

wallpaper, 287

MOTUs (Masters of the Universe), 234–235

Mount folder, 135

Mount options, 55, 170

“Mount point” setting, 55

Mount points

mapping to partitions, 136

for Windows partitions, 136

Mount points, partitioning disks

with an alternate install CD, 55

with a desktop CD, 48

Mounting/unmounting devices

automatically, 125

description, 125–126

digital cameras, 127

file access, recording, 170

file execution, prohibiting, 169

floppy disks, 127

folder for, 135

last-access log, disabling, 170

mount options, 170

noatime option, 170

nodev option, 169

noexec option, 169

nosuid option, 169

special device files, prohibiting, 169

suid restrictions, 169

troubleshooting, 126

USB keyrings, 126

Mouse behavior, Kubuntu, 266

Movement-disabled users. See Accessibility.

Movies. See Video.

Moving files and folders, 91, 344

Mozilla Web site, 72

MP3 format, 95, 98

Multimedia. See also Audio; Music; Sound;

Video.

Blender, 105–106

codecs, 94–95

compression. See Codecs.

Kubuntu, 266

production studio, 105–106

Ubuntu Studio, 314–315

Multiverse repository, 122, 157, 263

Music. See also Audio; Multimedia.

Amarok music manager, 276

Audio CD Extractor, 97–98, 108

buying, 98–99

Cool Streams, 276

copyright violations, 276

DRM (Digital Rights Management), 98, 276

Jamendo, 98

legal restrictions, 276

Magnatune, 98

Magnatune store, 276

managing, 276–277

online radio, 276

online stores, 276

portable music players, managing, 276

recording, 103, 108

Shoutcast Streams, 276

Ubuntu One Music Store, 98–99
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mv command, 344

My Computer, Ubuntu equivalent, 63

My Documents, Ubuntu equivalent, 63

Mythbuntu, 315

Naming folders, 90

nano command, 347

nano text editor, 347

Nautilus. See File Browser.

Nepomuk configuration, Kubuntu, 269

Nero Burning Rom, burning CDs/DVDs, 40

Netbook Edition. See also Netbook Remix.

2D launcher, 296–300

description, 37

installing, 294–296

launcher, 296–300

maximized windows, 300–301

recently used files, 300

scrolling, 299

switching to Ubuntu desktop, 301–302

vs. Ubuntu, 38

virtual desktops, 306–307

window listing, 300

Netbook Edition applications

Cellwriter, 303

character recognition, 304

Cheese, 302–303

ebook formats supported, 303

ebook reader, 303–304

Favorites list, 296–299

Fbreader, 303–304

handwriting recognition, 304

.lit files, converting, 303

note taking, 304–306

PDF annotation, 304–306

photography, 302–303

running, listing, 299

starting, 296–300

video, 302–303

Xournal, 304–306

Netbook Remix, 249. See also Netbook 

Edition.

Netbooks, definition, 294

Network & Connectivity section, 266

Network interface report, 346

Network Manager, 68

Network manager applet, 68

Network menu item, 63

Network Neighborhood, Ubuntu equivalent, 

63

Network Places, Ubuntu equivalent, 63

Networks

connection information, viewing, 68

editing connections, 68

enabling/disabling, 68

firewalls, 172–173

iptables command, 172–173

notifications, enabling/disabling, 68

security, 172–173

settings, changing, 266

New Printer wizard, 130–132

No open ports policy, 167

noatime option, 170

nodev option, 169

noexec option, 169

Non-Synaptic applications, installing, 122

nosuid option, 169

Note taking, 304–306

Notes, in the sidebar, 92

Notes option, 92

Notification area, 67–68

Notification of available upgrades, 120

Notification of new releases, 120

Novell, 247

NUMA, Ubuntu Server, 143

Numlock activation, 290
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OCFS2 filesystem, 144

Of installation CDs (images). See .iso files.

Office suite. See OpenOffice.org.

Official support, definition, 157

The Official Ubuntu Server Book, 173, 311, 352

Ogg Theora, 95

Ogg Vorbis, 95

Okular, 289

Older computers, running Ubuntu. See

Installing Ubuntu from alternate install

CD; Xubuntu.

Online radio, 276

Online resources. See also Help.

Answers, 323

archive management, 320

backup strategies, 139

Bazaar, 325

BIOS manual, 41

Blueprint, 323

bugs, reporting and tracking, 322

bulletin boards. See IRC (Internet Relay

Chat); Mailing lists; Wikis.

codecs, 94–95

community participation, 291

CVE numbers, 121

development discussions

See Blogs

See IRC (Internet Relay Chat)

See Mailing lists

See Web forums

See Wikis

Docky, 214

DRBD (Distributed Replicated Block

Device), 177

DVDs, format restrictions, 100

feature tracking, 323

Firefox extensions, 75

The Fridge, 74, 225–227

F-Spot Photo Manager, 99

GIMP help, 189

gNewSense, 317

GNOME-shell, 208–209

grep tutorials, 347

Guadalinex, 316

Inkscape, 193–194

installation CDs, 38–39

IRC channels, list of, 221

KDE (K Desktop Environment), 247

Kubuntu, installing, 37

Kubuntu wiki, 290

KVM virtualizer, 176

Launchpad, 39, 320

Launchpad Ground Control, 325

The Linux Documentation Project, 353

LinuxCommand.org, 353

mailing lists, 218

Malone, 322

Nepomuk, 269

Planet Ubuntu, 74, 230–231

Plasma, 257

podcasts, 96–97

RAID modes, 148

revision control system, 325

Rosetta, 321

Scribus, 199

security vulnerabilities, 120

sed tutorials, 347

Soyuz, 319–320

specification tracking, 323

support requests, tracking, 323

text files, searching and editing, 347

themes, 88

Ubuntu derivatives, 31–33

Ubuntu developer blogs, 74

Ubuntu One Music Store, 99

Ubuntu Server, security, 174
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Ubuntu Server Edition, 313

Ubuntu Studio, 314–315

Web forums, 221–222.  See also Ubuntu

Forums.

wikis, 223–225

Xubuntu, installing, 38

Zeitgeist, 208–210

Open applications, displaying, 69

Open Collaboration Services, 270–271

Open command, 212

Open source

history of, 5–7

philosophical goals, 20

Open Source Initiative, 6

OpenOffice.org

drawing. See Draw program.

file formats, 77

fonts, 76

Kubuntu, 277–278

OpenOffice.org, creating documents

mathematical expressions builder. See Math.

in PDF format, 78

presentations. See Impress.

spreadsheets. See Calc.

word processing. See Writer.

writing a letter, 75–78

OpenVZ, virtualization, 176

Operating systems. See specific operating

systems.

emulating. See Ubuntu Server virtualization.

running within operating systems. See

Ubuntu Server virtualization.

/opt folder, 135

Optional software, folder for, 135

Orange icon, 279

Orphan packages, removing, 166

OS virtualization, 176

Other permission, 169

Overlay mode, GNOME-shell, 207

Owner permission, 169

Ownership, changing, 345

Package management. See also APT (Advanced

Package Tool); MOTUs (Masters of the

Universe); Synaptic; Technical Board;

Ubuntu archive.

apt-cache utility, 160–163

apt-get utility, 160–163

aptitude utility, 165–166

building packages from source, 164–165

command-line tools, 158–159

Debian package manager, 158–159

default packages, 143

distribution upgrades, 163–165

downloading packages, 160

dpkg utility, 158–159

file owner, finding, 166

file provider, finding, 166

listing owned files, 166

listing packages, 159

malicious packages, 160

package information, displaying, 161–162

searching for packages, 161–162

system updates, with apt-get, 160–163

Package management, installing packages

with apt-get, 160–163

manually, 159–160

Package management, removing packages

with apt-get, 160–163

orphans, 166

Package management, security

patches, applying, 163–165

of third-party packages, 159–160

Packages

building from source, 164–165

definition, 116
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Packages, continued

extragears, 257

finding, 119–122.  See also Repositories;

Software Center.

information, displaying, 161–162

installing, 117–118

locations. See Repositories.

maintenance, responsibility for, 234–235,

237–238

policies, setting, 237–238

removing. See Removing packages.

software channels. See Repositories.

user involvement, 242–243

of widgets, 257

The panel, 61

Panel manager. See GNOME-shell.

Paravirtualization, 176

Parity drives, 148

Parley, 205

Partitioning disks

/home partition, 145–146

installing Ubuntu Server, 145–146

Kubuntu, 252

LVM (Logical Volume Manager), 150–152

swap partitions, encrypting, 155

/tmp partition, 145–146

Ubuntu Server security, 145

/var partition, 145–146

Partitioning disks, alternate install CD

adding partitions, 54–55

“Bootable flag” setting, 55

bootable partitions, specifying, 55

deleting partitions, 54

encryption, 53

filesystem, specifying, 55

“Format the partition” setting, 55

FREE SPACE line, 54

Guided—Use Entire Disk... options, 52–53

“Label” setting, 55

labeling partitions, 55

Manual option, 52

manually, 52

mount options, 55

“Mount point” setting, 55

mount points, 55

“Reserved blocks” setting, 55

root partition, creating, 54

settings, 55

sizing partitions, 54

“Typical usage” setting, 55

“Use as” setting, 55

Partitioning disks, desktop CD

adding a partition, 47

default filesystem, 47–48

definition, 44

for dual boot, 44–48

manually, 46–48

minimum number of partitions, 45

mount points, 48

Partitions

filesystem, changing, 136

mapping to mount points, 136

numbers, changing, 136

Windows, accessing from Ubuntu, 135–136

passwd command, 348

Passwords. See also Security.

for Administration features, 64

administrative access, 257

bypassing, 66

changing, 257, 348

changing users or groups, 65

for directory encryption, 154

guidelines for creating, 49

for new users, 124–125
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randomly generated, 65–66

for system settings, 264

PDF files

annotating, 304–306

viewing, 289

PDF files, creating with

Inkscape, 193

OpenOffice.org, 78, 278

Scribus, 197–198

Pen disks. See USB storage devices, keyring

devices.

Perens, Bruce, 6

Performance, analysis and monitoring, 103, 288

Performance Monitor, 288

Periodic table, 199–200

Permissions

changing, 272, 345

files, 340, 345

Ubuntu Server, 169–170

Persistence, USB storage devices, 56–57

Personal package archives (PPAs), 122

Personal section, 265

PEs (physical extents), 151–152

Philosophical goals of Ubuntu, 19–21

Photographs, editing. See Images (graphic),

editing.

Photographs, managing

F-Spot Photo Manager, 99, 128

GIMP Image Editor, 128

Photography, 302–303

Physical drive failure, RAID, 150

Physical storage, moving. See LVM (Logical

Volume Manager).

Physical volumes (PVs), 151–152

Physics simulator, 205

Pictures. See Drawing; Images (graphic),

editing; Photographs.

PIM (personal information manager)

Akonadi, 269

Evolution, 79

Kontact, 283

Pipelines, 341–342

PiTiVi movie editor, 102

Places menu, 63–64

Places option, 92

Planet Ubuntu, 74, 230–231

Plasma

adding widgets to, 257

backgrounds, 258

customizing, 257–259

GHNS (Get Hot New Stuff), 259–260

immutable desktop, 287

online resources, 257

removing widgets from, 257

templates, sharing, 259

wallpaper, 258

widgets, 257–258

Playing

audio CDs, 97–98, 108

video, 99–102

Plug-ins, Firefox, 75

PNG format, Inkscape, 193

Podcasts, 96–97

Pooling drives, RAID, 147

Pope, Alan, 237

Portable music players, managing, 276

POSIX model, 169

Posts, Ubuntu Forums, 332, 333–334

Power, electrical. See Electrical power.

Power Control section, 266

PowerPC support, 38

PowerPoint, 278

PPAs (personal package archives), 122

A Practical Guide to Linux® Commands..., 353
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Preferences. See Configuring; Customizing;

Kubuntu system settings; Software

Management, System Settings.

Preferences menu item, 64

Printer configuration, Kubuntu, 267

Printer configuration application, 130

Printer Configuration section, 267

Printers, configuring

adding the printer, 128

automatic detection, 130–132

driver support, checking, 128

drivers, specifying, 130

manufacturer, choosing, 130

model, specifying, 130

New Printer wizard, 130–132

Printer configuration application, 130

printing a test page, 132–133

remote printing, 133

Printing

last ten lines of log files, 172

from remote printers, 133

system information, 346

test pages, 132–133

version information, 346

working directory, 343

Private messaging, 220

Privileges. See Permissions.

Problems

reporting. See Launchpad; Malone.

solving. See Technical support; 

Troubleshooting.

Process information, displaying, 346

Processes, viewing, 346

/proc/sys folder, 135

Production studio, 105–106

Profile pictures, Ubuntu Forums, 336

Programming, user involvement, 242–243

Programs

adding. See Installing.

application. See Applications.

operating systems. See specific operating

systems.

emulating. See Ubuntu Server 

virtualization.

running within operating systems. See

Ubuntu Server virtualization.

packaged for installation. See Packages.

Project Timelord, 248

ps command, 346

PVs (physical volumes), 151–152

pwd command, 343

Python language, 25

QEMU virtualization, 175

QPL (Q Public License), 247

QT toolkit, 247

Quadrapassel, 103

Quality assurance, user involvement, 242

Quassel, 283

Question mark (?), wildcard character, 350

QuickTime, restrictions, 95

Radio, online, 276

RAID (redundant array of inexpensive disks)

array failure, 150

array management. See LVM (Logical Volume

Manager).

backing up data, 149

choosing, 148

data replication, 146

degraded mode, 150

description, 146–148

documentation, 156

fault tolerance, 151, 154
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levels, 147–148

modes, 148

parity drives, 148

physical drive failure, 150

pooling drives, 147

RAID 0, 147

RAID 1, 147

RAID 5, 147

setting up, 148–150

space requirements, 147

spare devices, 149–150

striped set, 147

RAID 0, 147

RAID 1, 147

RAID 5, 147

RAID array failure, 150

Rankin, Kyle, 352

rar backup program, 138

Raymond, Eric S., 6

Reading tutorial, 205

RealMedia, restrictions, 95

Recent Documents menu item, 64

Recently used

applications, 207, 255

documents, 64, 255

files, 300

Recently Used tab, 255

Recently-used documents, listing, 64

Recognized derivatives, 314–315

Recording music or sound, 103, 108

Rectangles, drawing, 189–193

Red Hat Cluster Suite, 144

Redundancy, LVM, 154

Redundant array of inexpensive disks (RAID).

See RAID (redundant array of

inexpensive disks).

Release notifications, 120

Releases. See also specific releases.

first, 2

LTS (Long Term Support), 3, 24–25

new, updating to. See Installing Ubuntu

updates.

scheduling goals, 23–24

support duration, 24

Reminders. See Calendars.

Remnant, Scott, 238

Remote

desktop connection, 288–289

dial-up tool, 288

login, 155

printing, 133

Remote control, Totem media player, 101

Removing. See also Deleting.

programs. See Adding/removing programs.

user accounts, 348

user groups, 348

Removing packages

with apt-get, 160–163

orphan packages, 166

orphans, 166

with Synaptic, 118–119

Renaming folders, 90

Rendering, 105–106

Reporting bugs. See Malone.

Repositories. See also APT (Advanced Package

Tool); Ubuntu archive.

backports, 157

definition, 116

Kubuntu, 262–263

main, 157, 263

multiverse, 122, 157, 263

PPAs (personal package archives), 122

switching, 262–263

third-party, 263
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Repositories, continued

Ubuntu archive, 156–157

universe, 122, 157, 263

Repositories, restricted

definition, 157

gNewSense, 316–317

Kubuntu, 263

Ubuntu, 157

Repositories, Ubuntu archive

backports, 157

main, 157

multiverse, 122, 157

restricted, 157

universe, 157

“Reserved blocks” setting, 55

Resizing monitors, 289

Resolution, screen, 266

Resource limits, 170–171

Restart option, 71

Restarting

the computer, 71

Kubuntu, 255

Restricted repositories, 157, 263, 317

Restrictions

codecs, 94–95

MP3 format, 95

multimedia formats, 95

packages, 157

QuickTime, 95

RealMedia, 95

repositories, 157, 263, 317

Windows Media Format, 95

Revision control system, 324–325

Rhythmbox, 96

Riddell, Jonathan, 248

Ripping audio CDs, 97–98, 108

rm command, 344–345

Root account

enabling, Ubuntu Server, 156

sudo instead of, Kubuntu, 257

Ubuntu Server, enabling, 156

/root folder, 135

Root partition, creating, 54

Rosetta, 29, 320–321

Rotating monitors, 289

RSS feed indicator, 279

RSS feeds, tracking, 286–287

rsync backup program, 138

SABDFL (self-appointed benevolent dictator

for life), 232, 238

Saving

from Inkscape, 192–193

in PDF format. See PDF files, creating.

Writer documents, 77–78

/sbin folder, 135

Scalable Vector Graphics (SVG), 104, 192–193

Scheduling events. See Calendars.

Schools, Ubuntu for. See Edubuntu.

Schwartz, Jonathan, 178

Science applications, 205

Screens. See also Monitors.

capturing, 289

corner features, 70

locking, 71, 89, 255

multiple, 350–352

orientation, 266

resolution, 266

Screensavers

configuring, 88–89

locking the screen, 89

Scribus. See also OpenOffice.org.

creating a document, 194–199

exporting to PDF, 197–198
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help, 199

online resources, 199

package description, 106

saving to SLA format, 198

user interface, 107, 194

Scribus, graphic images

DPI error, 197

editing, 194

image frames, 196–197

inserting, 196–197

supported formats, 197

Scribus, text

adding, 195

editing, 194

importing Microsoft Word documents, 195

overflowing the frame, 196

text frames, 195

Scrolling, Netbook Edition, 299

Search Bar, 255

Search for Files menu item, 64

Search tools. See also Finding.

desktop search box, 74

Firefox, 74

Google, Kubuntu, 275, 279

indexing searchable material, 108

Tracker Search Tool, 108

Searching

Desktop Search configuration, Kubuntu,

269–270

in Firefox, 74

indexing files and folders, 270

for man files, 349

for packages, 161–162

Strigi desktop search, 270

Searching for applications

GNOME-shell, 207

Kubuntu, 269–270

Searching for files

with grep command, 347

Kubuntu, 269–270

in package repositories, 159

from Ubuntu desktop, 63–64

Security. See also Passwords.

Firefox extensions, 75

locking the screen, 70–71, 89

networks, 172–173

patches, applying, 163–165

of third-party packages, 159–160

Trojan horses, 159–160

Ubuntu Server. See Ubuntu Server security.

viruses, 159–160

vulnerability identifier, 121

worms, 159–160

Security-related updates, 120, 121

sed (Stream EDitor), 347

sed command, 347

Selecting files and folders, 91–92

Self-appointed benevolent dictator for life

(SABDFL), 232, 238

Semantic Desktop, enabling, 270

Sending messages, 281–282. See also E-mail.

Servers

connecting to, 64

vs. desktop machines, 24–25.  See also

Ubuntu Server.

e-mail, 81, 83

installing from alternate install CD, 51

Service and support. See Technical support.

Service Manager section, 269

Settings, partitioning disks, 55

Shortcuts

to applications, 66

icons, 66

keyboard, GNOME-shell, 208
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Shortcuts,  continued

kioslaves, 274–275

Konqueror, 274–275

Shoutcast Streams, 276

Shut Down option, 71

Shutting down, 71, 255. See also Logging out.

Shuttleworth, Mark. See also History of

Ubuntu.

Blueprint, 323

Bug #1, 25–26

Community Council member, 237

on meritocracy, 231

praise from Sum Microsystems, 178–179

profile, 7–9

SABDFL (self-appointed benevolent dictator

for life), 232, 238

space travel, 8

starting Ubuntu, 2

on the Technical Board, 238

Warthogs, 9–10

Shuttleworth, Mark, companies founded by. See

also Canonical Ltd..

HBD (Here Be Dragons), 9

Thawte, 8

TSF (The Shuttleworth Foundation), 8

Sidebar, File Browser, 92

Signatures, Ubuntu Forums, 336

Silber, Jane, 27

Simon Says game, 205

Simple Backup Suite, 138

SLA format, saving from Scribus, 198

Slackware, 14

Sleep option, 71

SLS (Softlanding Linux System), 14

Sobell, Mark G., 353

Social networking

chats, 78.  See also IRC (Internet Relay Chat).

Open Collaboration Services, 270–271

Software Center

interface, 114–115

listing applications, 116

starting, 114

Software channels, 116. See also Repositories.

Software Management. See also Kubuntu

customization; Kubuntu system

administration.

adding/removing programs, 260–262

KPackageKit, 260

Look & Feel section, 265

main repository, 263

managing repositories, 262–263

multiverse repository, 122, 263

Network & Connectivity section, 266

password, changing, 257

Personal section, 265

restricted repository, 263

third-party repositories, 263

universe repository, 122, 263

update notification, 264

upgrading Kubuntu, 264

Software Management, System Settings. See also

Kubuntu system settings.

Add or Remove Software section, 267

Advanced tab, 264, 267

Advanced User Settings section, 269–271

Computer Administration section, 266

Display section, 266

General Tab, 264

Look & Feel section, 265

overview, 264–265

Personal section, 265

Power Control section, 266

Printer Configuration section, 267

Semantic Desktop, enabling, 270

Service Manager section, 269

System section, 267
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Software stores. See Repositories.

Software upgrades, installing. See Installing

Ubuntu updates.

Sound. See Audio; Multimedia; Music.

Sound applet, 68

Sound cards, mixer settings, 67

Sound Juicer. See Audio CD Extractor.

Sound Recorder, 103

Source code, free access to, 5

Soyuz, 30, 319–320

Space exploration, 202–203

Spanish language distribution, 316

Specification tracking, 30

Speedcrunch, 288

Spelling, 201

Spillner, Josef, 259

Spin-offs from Ubuntu, 31–33

Splash screens, 265

Spools, 145

Sprints, 227–229

ssh client, 145

Stallman, Richard M.

chief gnuisance, 317

free software, 4–5

gNewSense, 316–317

GNU project, 5

history of Ubuntu, 3–6

Linux, 5

open source, 5–7

Standby mode, monitors, 266

Starting

File Browser, 89

Firefox, 73

GIMP (GNU Image Manipulation Program),

183

Inkscape, 189

Kontact, 284

Netbook Edition applications, 296–300

Software Center, 114

Synaptic, 117

Terminal, 339–340

Starting applications. See also Applications

menu.

with Docky, 212–214

with GNOME Do, 211–212

Kubuntu, 254–255, 284

Ubuntu, 62–63

Starting/stopping services, Kubuntu, 269

Startup services, configuring in Kubuntu, 269

Step, 205

Stick disks. See USB storage devices, keyring

devices.

Storage, physically moving. See LVM (Logical

Volume Manager).

Storage fluidity, LVM, 154

Stream EDitor (sed), 347

Strigi desktop search, 270

Striped RAID sets, 147

Stroke color, 189–190

Structures and processes, responsibility for, 236

Subforums, 332

Subprojects of Ubuntu, 31–33

sudo command

instead of a root account, 156, 257

superuser privileges, 167–169, 342–343

sudoers database, 168–169

Sudoku, 104

suid restrictions, 169

Summits, 227–229

Sun Microsystems, 176, 179

Superusers

home directory, 135

reserving space for, 55

running Terminal commands, 342–343

software folder, 135

Support. See Technical support.
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Support tracking, 30

SVG (Scalable Vector Graphics), 104

SVG (Scalable Vector Graphics) format, 192–193

Swap partitions, encrypting, 155

Switch from... option, 71

Switching

between applications, 69, 212–214

File Browser views, 91

between Kubuntu and Ubuntu, 249–250

Netbook Edition to Ubuntu desktop,

301–302

Ubuntu Server consoles, 145

users, 71

Synaptic

can’t find an application, 122

description, 117

finding, 117

finding packages, 119–120

installing packages, 117–118

name origin, 117

removing packages, 118–119

starting, 117

syslog log file, 171

System administration

customizing your system. See Customizing.

Kubuntu. See Kubuntu customization;

Kubuntu system administration;

Software Management.

troubleshooting. See Troubleshooting system

administration.

System administrator account, Ubuntu Server,

155–156

System information

command-line interface to. See Terminal

commands, system information.

printing, 346

System log files. See Log files.

System Logs Viewer, 288

System menu, 64

System Monitor, 103

System problems, troubleshooting. See

Troubleshooting system problems.

System resource limits, Ubuntu Server, 170–171

System section, 271–272

System settings, Kubuntu. See Kubuntu system

settings; Software Management, System

Settings.

System status, folder for, 135

System updates, with apt-get, 160–163

Systemwide changes, monitors, 287

Tagging bookmarks, 74

tail utility, 172

Taskbar, 61, 69–70

Team councils, 232–233

Teams

creating and dissolving, 236

LoCos (local community teams), 233–234

meritocracy, 231

MOTUs (Masters of the Universe), 234–235

overview, 232–233

team councils, 232–233

Technical Board, 237–238

Technical direction, setting, 237

Technical goals of Ubuntu, 23–25

Technical support. See also Bugs, reporting and

tracking; Help; Online resources;

Troubleshooting; Ubuntu community,

communication venues.

accessing, 64

Answers, 323

Canonical Ltd., 28–29

cycles, Ubuntu archive, 157

LTS (Long Term Support), 3, 24–25
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tracking, 30

user involvement, 240

Templates, GIMP, 182, 184

Terminal

description, 137

finding, 103

starting, 339–340

window, illustration, 340

Terminal commands

&& (ampersands), running commands

conditionally, 350

@ (at sign), in command-line username, 339

$ (dollar sign), UNIX shell symbol, 160, 339

- (hyphen), dash in commands, 341

? (question mark), wildcard character, 350

| (vertical bar), pipe symbol, 137, 341

[ ] (brackets), wildcard characters, 350

[! ] (brackets, exclamation point), wildcard

characters, 350

; (semicolon), running commands

sequentially, 350

~ (tilde), home directory indicator, 160, 339,

344

documentation. See Man pages.

executing multiple, 350

help, 343

-help, 348

man pages, accessing, 343

passing output. See Pipelines.

pipelines, 137, 341–342

A Practical Guide to Linux® Commands..., 353

printing system or version information, 346

running as a superuser, 342–343

running sequentially, 350

stringing together. See Pipelines.

sudo, 342–343

wildcards, 349–350

Terminal commands, files and folders

cat, 341, 347

cd, 341, 344

changing directories, 341

changing folders, 344

chmod, 345

chown, 345

contents, viewing, 341

copying, 344

cp, 344

creating folders, 345

current folder, identifying, 343

deleting, 344–345

grep, 347

less, 347

listing, 340, 345

ls, 340, 345

mkdir, 345

moving, 344–345

mv, 344

nano, 347

ownership, changing, 345

permissions, changing, 345

printing working directory, 343

pwd, 343

rm, 344–345

sed, 347

text files, searching and editing, 347

Terminal commands, system information

df, 345

disk space usage, displaying, 345

free, 345

HAL devices, listing, 346

hardware, listing, 346

ifconfig, 346

iwconfig, 346

kernel, checking, 346
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Terminal commands, system information,

continued

lsb_release -a, 346

lsb_release -a command, 346

lshal, 346

lshw, 346

lspci, 346

lsusb, 346

memory usage, displaying, 345

network interface report, 346

process information, displaying, 346

processes, viewing, 346

ps, 346

top, 346

uname -a, 346

USB buses, listing, 346

version information, printing, 346

wireless network information, displaying,

346

Terminal commands, users and groups

addgroup, 348

adduser, 168

delgroup, 348

deluser, 348

groups, adding/removing, 348

passwd, 348

passwords, changing, 348

user accounts, adding/removing, 348

users logged on, displaying, 348

who, 348

Tetris. See Quadrapassel.

Text

GIMP, 185

Inkscape, 192

Text, Scribus

adding, 195

editing, 194

importing Microsoft Word documents, 195

overflowing the frame, 196

text frames, 195

Text Editor, 102

Text editors

Kate, 288

Kubuntu, 288

nano, 347

sed (Stream EDitor), 347

Text files, searching and editing, 347

Thawte, founding of, 8

The Shuttleworth Foundation (TSF), 8

Themes and backgrounds

changing, 87–88

customizing, 87–88

installing, 88

Kubuntu. See Plasma.

online resources, 88

splash screens, 265

Third-party packages, security, 159–160

Third-party repositories, 263

Threads, Ubuntu Forums, 332, 333–334

3D mapping, 289

3D modeling, 105–106

Thumbnail file views, 209

Tilde (~), home directory indicator, 160, 339,

344

Time and date. See Clock.

Time zone, setting, 52, 251

/tmp partition, 145–146

Toilet paper template, 182, 184

top command, 346

Torvalds, Linus, 5

Totem media player, 99–100, 101

Touch-typing tutorial, 203

Tracking

bugs. See Bugs, reporting and tracking;

Launchpad; Malone.

distribution changes, 15–16
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specifications, 30

support, 30

system features, 30

Translation and localization

localization teams, 320–321

personal applications, 86

software for. See Rosetta.

user involvement, 242

Translations. See Rosetta.

Trash (wastebasket), 70

Tree option, 92

Tribute weeks, Ubuntu Forums, 337

Trojan horses, 159–160

Trolltech, 247

Troubleshooting. See also Technical support.

BIOS configuration problems, 41

DVD encryption, 100

e-mail, unable to connect to server, 83

encryption, DVDs, 100

hardware, unmounting a device, 126

home directory lockout, 155

multimedia, restricted formats, 95

problem reporting. See Launchpad; Malone.

RAID array failure, 150

Troubleshooting system administration

command options, help for. See man pages.

copying files between computers, 64

help for commands. See man pages.

Synaptic can’t find an application, 122

Troubleshooting system problems

displaying hidden files and folders, 134

non-Synaptic applications, installing, 122

Troy, Ryan (ubuntu-geek), 328–329

TSF (The Shuttleworth Foundation), 8

Tutu, Desmond, 11

Tux Paint, 205

2D launcher, 296–300

“Typical usage” setting, 55

Ubiquity installer program, 250–253

Ubucons, 229–230

Ubunteros, 239

Ubuntites. See Ubunteros.

Ubuntu. See also Derived distributions.

CoC (Code of Conduct), 21–23

derivatives. See Derived distributions.

desktop. See Desktop (Ubuntu).

developer blogs, 74

for educational environments. See Edubuntu.

financial support for. See Canonical Ltd.;

Ubuntu Foundation.

history of. See History of Ubuntu.

for KDE (K Desktop Environment). See

Kubuntu.

LCoC (Leadership Code of Conduct), 23

for multimedia production. See Ubuntu

Studio.

on older computers. See Xubuntu.

spin-offs, 31–33

subprojects, 31–33

technical goals, 23–25

for use in schools. See Edubuntu.

Windows-equivalent programs. See Windows

programs, Ubuntu equivalents.

word origin, 10–11

for Xfce window management system. See

Xubuntu.

Ubuntu archive. See also Ubuntu Server package

management.

APT (Advanced Package Tool), 157–163

apt-cache utility, 160–163

apt-get utility, 160–163.  See also aptitude

utility.

aptitude utility, 165–166.  See also apt-get

utility.

backports repository, 157

binary uploads, 164
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Ubuntu archive, continued

installing packages, with apt-get,

160–163

LTS (Long Term Support), 157

main repository, 157

multiverse repository, 122, 157

official support, 157

repositories, 156–157

restricted repository, 157

structure of, 143

support cycles, 157

system updates, with apt-get, 160–163

universe repository, 122, 157

Ubuntu archive, removing packages

with apt-get, 160–163

orphans, 166

Ubuntu community

activists. See Ubunteros.

CoC (Code of Conduct), 21–23

description, 17–18

giving back to, 290–291

history of, 17–18

LCoC (Leadership Code of Conduct), 23

membership requirements, 18

philosophical goals, 19–21

Ubuntu community, communication venues.

See also Developer contacts.

announcements, 219

bulletin board. See The Fridge.

conferences, 229–230

developer sprints, 227–229

developer summits, 227–229

development discussions. See IRC (Internet

Relay Chat); Mailing lists; Wikis.

The Fridge, 74, 225–227

general chat. See IRC (Internet Relay Chat);

Mailing lists; Wikis.

IRC (Internet Relay Chat), 219–221

mailing lists, 218–221

Planet Ubuntu blogs, 74, 230–231

sprints, 227–229

summits, 227–229

support-oriented. See IRC (Internet Relay

Chat); Mailing lists; Wikis.

Ubucons, 229–230

user conferences, 229–230

Web forums, 221–222.  See also Ubuntu

Forums.

wikis, 223–225

Ubuntu community, user involvement levels

advocacy, 240

artwork, 241–242

documentation, 241

ideas and feedback, 241

packaging, 242–243

programming, 242–243

quality assurance and bugs, 242

support, 240

translation and localization, 242

Ubuntu community governance system. See also

Canonical Ltd.; Teams; Ubuntu

Foundation.

code revisions, approving, 235

Community Council, 235–237

dispute arbitration, 235–236

feature goals, maintaining, 237

goals, 232

package maintenance, 234–235, 237–238

package policy, setting, 237–238

SABDFL (self-appointed benevolent dictator

for life), 232, 238

structures and processes, 236

Technical Board, 18, 237–238

technical direction, setting, 237

Ubunteros, 239

Ubuntites. See Ubunteros.
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Ubuntu community governance system,

Ubuntu members

activists. See Ubunteros.

approving, 236

membership levels, 239

official membership, 239

rights and privileges, 239–240

Ubuntu community teams

creating and dissolving, 236

LoCos (local community teams), 233–234

meritocracy, 231

MOTUs (Masters of the Universe), 234–235

overview, 232–233

team councils, 232–233

Ubuntu Forums

asking questions, 332, 334–335

avatars, 336

coffee references, 336

Forums Code of Conduct, 337

getting help for, 332

history of, 328–329

key people, 335–336

messages. See Posts.

organization of, 334–335

overview, 328

participating in, 329–334

posts, 332, 333–334

profile pictures, 336

setting up an account, 329–334

signatures, 336

staff, listing, 335–336

subforums, 332

threads, 332, 333–334

topics. See Threads.

tribute weeks, 337

user rank image, 336–337

usernames, 329

Web forums, 221–222

Ubuntu Foundation

CoC (Code of Conduct), 21–23

description, 30–31

geographical location, 30

LCoC (Leadership Code of Conduct), 23

philosophical goals, 19–21

Ubuntu Help Center, 64

#ubuntu IRC channel, 221

Ubuntu members

approving, 236

membership levels, 239–240

official membership, 239

rights and privileges, 239–240

Ubuntu Netbook Edition. See Netbook Edition.

Ubuntu One application, 78–79

Ubuntu One Music Store, 98–99

Ubuntu Server

cloud computing, 177–178

contact information, 174

custom server kernel, 143

description, 142–144

disk replication, 177

DRBD (Distributed Replicated Block

Device), 177

ecryptfs, 154–155

encryption, 154–155

GFS (Global File System) support, 144

home directory, encrypting, 155

installing. See Installing Ubuntu Server.

ipvsadm utility support, 144

keepalived utility, 144

Linux Virtual Server utility support, 144

log files, 171–172

NUMA support, 143

OCFS2 filesystem support, 144

The Official Ubuntu Server Book, 173, 311, 352

partitioning, 145–146

passwords, for directory encryption, 154
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Ubuntu Server, continued

Red Hat Cluster Suite support, 144

swap partitions, encrypting, 155

Ubuntu Server Edition, 313

Ubuntu Server package management. See also

APT (Advanced Package Tool); Ubuntu

archive.

apt-get utility, 160–163.  See also aptitude

utility.

aptitude utility, 165–166.  See also apt-get

utility.

Ubuntu Server security. See also Security.

adduser command, 168

administrator account, 155–156

contact information, 174

deluser command, 168

filesystems, 169–170

firewall tables, 172–173

group permission, 169

home directory encryption, 155

iptables command, 172–173

log files, 145

mount options, 170

no open ports policy, 167

noatime option, 170

nodev option, 169

noexec option, 169

nosuid option, 169

online resources, 174

other permission, 169

overview, 167

owner permission, 169

partitions, 145

permissions, 169–170

POSIX model, 169

root account, enabling, 156

spools, 145

sudo command, 156, 167–169

sudoers database, 168–169

system resource limits, 170–171

user account administration, 167–169

visudo command, 168

Ubuntu Server virtualization

Bochs, 175

common hardware emulators, 175

containerization, 175

definition, 174

full virtualization, 175

hardware emulation, 175

hypervisor, 175–176

IBM, 175

KVM, 175

Linux-VServer projects, 176

MIT, 176

OpenVZ, 176

OS virtualization, 175

paravirtualization, 175

preferred solution, 176

QEMU, 175

Sun Microsystems, 176

types of, 175–176

VirtualBox, 176

VMware, 174

Xen, 176

XVM, 176

xVM, 176

zoning, 175

z/VM, 175

Ubuntu Software Center. See Software Center.

Ubuntu Studio, 314–315

#ubuntu+1 IRC channel, 221

ubuntu-announce mailing list, 219

#ubuntu-devel IRC channel, 221

ubuntu-devel mailing list, 219

ubuntu-devel-announce mailing list, 219

ubuntu-devel-discuss mailing list, 219
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ubuntu-geek (Ryan Troy), 328–329, 335

#ubuntu-offtopic IRC channel, 221

uname -a command, 346

UNetbootin, 57

Uninstalling. See Removing.

Universe repository, 122, 157, 263

UNIX shell symbol ($), 160

Unmounting a device. See

Mounting/unmounting devices.

Update Manager, 109–111

Updating Ubuntu. See Installing Ubuntu

updates.

Upgrade notification, 264

Upgrading Kubuntu, 264

Upgrading Ubuntu, 109–111. See also Installing

Ubuntu.

Usability, 70

USB storage devices. See also Disk storage.

accessing, 276

buses, listing, 346

copying files to the hard disk, 126

installing Ubuntu from, 56–57

keyring devices, 126

making bootable, 57

mounting/unmounting, 126

persistence, 56–57

“Use as” setting, 55

User accounts

adding, 168, 348

adduser command, 168

administration, Ubuntu Server, 167–169

deleting, 168, 348

deluser command, 168, 348

groups. See User groups.

hostname, specifying, 49

passwords, selecting, 49, 56

Ubuntu Forums, 329–334

usernames, for new user accounts, 49, 55–56

User accounts, configuring

from alternate install CD, 55–56

from desktop CD, 48–49

User community. See Ubuntu community.

User conferences, 229–230

User groups

addgroup, 348

adding/removing, 348

delgroup, 348

User involvement levels

advocacy, 240

artwork, 241–242

documentation, 241

ideas and feedback, 241

packaging, 242–243

programming, 242–243

quality assurance and bugs, 242

support, 240

translation and localization, 242

User profiles, educational applications, 199

Usernames

in command lines, 339

Kubuntu, configuring, 253

for new user accounts, 49, 55–56

Ubuntu Forums, 329

Users

adding, 65–66, 124–125, 272

deleting, 125

group memberships, 125

logged on, displaying, 348

rank image, Ubuntu Forums, 336–337

/usr folder, 135

/var folder, 135

/var partition, 145–146

Vendor lock-in, 77

Verisign, 8

Version, choosing for installation, 36–37
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Version control tool, 29–30, 324–325

Version information, printing, 346

Vertical bar (|), pipe symbol, 137, 341

VGs (volume groups), 151–152

Video. See also Multimedia.

creating, 102

DVD encryption, 100

home theater software, 315

Netbook Edition, 302–303

PiTiVi movie editor, 102

playing, 99–102

required codecs, 99

Totem media player, 99

watching, 99–102

Virtual company, 11–12

Virtual computer. See Dual boot; Ubuntu Server

virtualization.

Virtual desktops, 69–70, 306–307

VirtualBox, virtualization, 176

Virtualization. See Ubuntu Server virtualization.

Viruses, 159–160

Visual themes. See Themes and backgrounds.

Visually-disabled users. See Accessibility.

visudo command, 168

VMware, 174

Volkerding, Patrick, 14

Volume control, 67

Volume groups (VGs), 151–152

Wallpaper, 287. See also Themes and

backgrounds.

Warthogs

history of, 2, 9–10

software ideals, 10

Warty Warthog, 2

Wastebasket (trash), 70

Watching video. See Playing, video.

Web browsers. See also Firefox; Konqueror.

Firefox, 279–280

Konqueror, 278–279

Web feeds. See RSS feeds.

Web forums, 221–222. See also Ubuntu Forums.

Web page editor, 106, 107

Web searches, Kubuntu, 275

Web sites

automatic content retrieval, 74

bookmarking, 279

browsing. See Firefox; Konqueror.

Webmail, Evolution support for, 80

What’s Up Tonight?, 203

who command, 348

Widgets, 257–258

Wikis

description, 223–225

online resources, 223–225

Wildcards, 349–350

Window manager, alternatives. See GNOME-

shell.

Windows

creating Ubuntu installation CDs, 40

emulation, 139–140

filesystem, vs. Linux, 133–134

installing Ubuntu from, 57

sharing filesystems with Ubuntu, 48

Ubuntu compatibility, 139–140

Windows

grouping, 208

listing, Netbook Edition, 300

open, cycling through, 208

Windows Installer, 57

Windows Media Format, restrictions, 95

Windows partitions

accessing, 275–276

mount points, creating, 136

sharing with Ubuntu, 135–136.  See also Dual

boot.
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Windows programs, Ubuntu equivalents

My Computer, 63

My Documents, 63

Network Neighborhood, 63

Office. See OpenOffice.org.

system tray, 67–68

Wine Windows Emulator, 139–140

Wireless network information, displaying, 346

Word

documents, importing to Scribus, 195

Ubuntu/Windows equivalent, 278

Word processing. See also Scribus.

Word, 278

Word Processor, 278

Word processing, Writer

choosing fonts, 76

file formats, 77

in Kubuntu, 278

saving documents, 77–78

writing a letter, 75–78

Word Processor, 278

Working directory, printing, 343

Workspaces, 69–70, 208

World atlas, 204–205

Worms, 159–160

Writer

choosing fonts, 76

file formats, 77

in Kubuntu, 278

saving documents, 77–78

writing a letter, 75–78

Wubi, 57

XDG Base Directory Specification, 273

XDG directories, 273–274

Xen, virtualization, 176

Xournal, 304–306

Xubuntu, 38, 314

XVM, virtualization, 176

xVM, virtualization, 176

Yahoo! Mail, Evolution support for, 80

zcat command, 172. See also cat command.

Zeitgeist

calendar bar, 209–211

file management, 209

getting, 209

installing, 209

online resources, 208–210

thumbnail views, 209

zeitgeist-daemon, 209

zeitgeist-datahub, 209

zgrep command, 172. See also grep command.

Zimmerman, Matt, 238

zless command, 172. See also less command.

Zoning, virtualization, 175

z/VM, virtualization, 175
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